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1. STANDARD OPERATING PROCEDURES
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SOP 1. PRE-SCANNING PROCEDURES 

SOP 1.1. Selection of skeletal material for scanning 
UP and SMU 

(1.0) Purpose 

The purpose of this document is to describe the skeletal elements that will be selected for 
scanning and what the exclusion criteria for the selection are. These criteria will ensure that 
only the most complete and undamaged (not altered by pathology, healed trauma, or 
postmortem damage) skeletal elements will be selected for scanning and will be added to the 
Bakeng se Afrika digital skeletal repository.  

(2.0) Scope 

This document and the guidelines herein will be used by skeletal collections managers or 
curators as well as by any researchers scanning skeletal material that will be added to the 
Bakeng se Afrika digital skeletal repository, including but not limited to the curator of  the 
Kirsten Skeletal Collection (KSC, housed at the Stellenbosch University), the curator of the 
Pretoria Bone Collection (PBC, housed at the University of Pretoria) and the curator of the 
Human Bone Collection (HBC, housed at the Sefako Makgatho Health Sciences University). 

(3.0) Definitions 

The following terminology will be used throughout the standard operating procedures for 
skeletal element selection. Definitions are taken from The Human Bone Manual by T.D. 
White and P.A. Folkens (2005) (see Figure 1).  

• Skull: the bones of the head, including both cranium and mandible
• Mandible: lower jaw
• Cranium: the bones of the skull except for the mandible
• Calvaria: the cranium not including the face
• Calotte: the calvaria without the base
• Cranial vault: in this instance the vault refers to the part of the calotte that is cut and

separated from the rest of the cranium during dissection, in order to remove the brain
• Dentition: the teeth
• Femur: long bone of the thigh
• Radius: one of the two long bones of the forearm ± from elbow to wrist on the thumb

side

• Axial skeleton: bones of the trunk including the vertebrae, ribs and
sternum

• Postcrania: all bones except the cranium and mandible
• Proximal: nearest to the axial skeleton
• Distal: opposite of proximal; farthest from the axial skeleton
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• Epiphyses: the cap at the end of a long bone that develops from secondary 
ossification centers  

• Diaphysis: the shaft of the long bone  
• Midshaft: the midpoint of the diaphysis (shaft of the bone) 

 
• Cancellous bone: spongy, porous lightweight bone found under protuberances where 

tendons attach, in vertebral bodies, in the needs of long bones, in short bones, and 
within flat bones (also called trabecular bone) 

• Cortical bone: the solid, dense bone that is found in the walls of bone shafts and on 
external bone surfaces (also called compact bone) 

 
• Pathological lesion: an injury or wound; an area of pathologically altered tissue 
• Antemortem trauma/changes: alterations to the bone that occur before the death of 

an individual (usually present with indicators of healing such as smoothed or rounded 
edges)  

• Postmortem damage: damage that occurred to the bone after moisture was removed 
from the bone (damage to dry bone); usually associated with colour differences 
between the fracture edge and the bone surface  

 
(4.0) Roles and Responsibilities 

Collections managers/curators:  

• Provide database of appropriate bones in the skeletal collection from which to select 
the specimens for scanning  

• Provide a maximum number of bones that can be taken for scanning at a time 
• Depending on institution, check whether the relevant bones are suitable for scanning 

(i.e., check for any of the exclusion criteria and remove from sample if necessary)  

Researchers (if applicable):  

• Depending on institution, check whether bones are appropriate for scanning (i.e., 
check for any of the exclusion criteria and remove from sample if necessary)  

(5.0) Procedures 

The skeletal material from each of the skeletal collections (Kirsten Skeletal Collection, 
Pretoria Bone Collection, Human Bone Skeletal Collection) will contribute a percentage 
towards the contents of the Bakeng se Afrika digital skeletal repository. As a variety of age 
groups, ancestry groups and sexes are necessary to create a holistic digital repository, each 
sex, ancestry and age group will make up a certain percentage of the repository (Table 1). 
The total number of skeletons available for scanning determines the number of skeletons that 
correspond to the percentages; however, the total number can only be determined once all 
unsuitable skeletons, as determined by the exclusion criteria, have been removed from the 
total sample.   

The following skeletal elements will be assessed for each individual and if present and 
complete with limited damage (postmortem, antemortem or pathology), the individual can 
be added to the total sample for scanning:  
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1) The cranium (the cranial vault and the rest of the cranium need to be joined together
using Prestick or masking tape (non-destructive) so that the cranium is in one piece
– if successful reconstruction is not possible – exclude from sample). If no teeth are
present (postmortem or antemortem loss) in the maxilla, the cranium can still be
scanned, however, the scan for dentition will be excluded.

2) The mandible (in one piece – if cut or broken and can be reconstructed successfully
using Prestick or masking tape (non-destructive) with minimal bone loss or
distortion, then the mandible can be used. If successful reconstruction is not possible,
then the bone has to be excluded from the sample). Loose teeth should be placed back
in the appropriate alveolar socket and held in place with masking tape.

3) The maxillary dentition – in order to scan the dentition a minimum of 4 teeth per
maxilla have to be present, otherwise the dentition should not be scanned. If at least
four teeth are present, then the cranium can be considered for scanning with a focus
on dentition. Loose teeth should be placed back in the appropriate alveolar socket and
held in place with masking tape. If the teeth cannot be replaced in the bone, the teeth
are not counted towards the minimum of four teeth that need to be present for
scanning. If no teeth/ not enough teeth are present (postmortem or antemortem loss),
the cranium and mandible can still be scanned separately, but the scan for dentition
should be excluded for the individual. If the teeth to be scanned are mostly replaced
by metallic dental fillings, those teeth should not be included or counted as the
minimum number of teeth required for scanning. Furthermore, if the metallic fillings
are present in all teeth, the dentition should not be scanned, as the metal will create
artefacts in the scans, which can interfere with the reconstruction and analysis of the
scans.

4) The left* femur (any bones with healed fractures or extensive pathological
conditions, as well as any bones demonstrating surgical interventions, such as
prosthetics, screws and plates, should be excluded).

5) The left* radius (any bones with healed fractures or extensive pathological
conditions, as well as any bones demonstrating surgical interventions, such as
prosthetics, screws and plates, should be excluded).

*Note: for long bones, the left side is typically used; however, if the left is absent or has been
excluded, then the right side may be used instead. If neither left nor right is available, then
that bone will simply be excluded from the scans for that particular individual.
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Figure 1. Image of annotated skeletons taken from Encyclopaedia Britannica (Available at:  
https://www.britannica.com/science/human-skeletal-system) 
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Table 1. Percentage of each demographic group that will constitute the initial sample of the Bakeng se 
Afrika digital skeletal repository.  

Demographic 
profile Age cohort 

Approx. percent of 
repository (%) [approx. 

indiv. numbers] 

Maximum number 
available in cohort 
(PBC + KSC)*** 

Collection(s) 

Black Males 

18-29 2 [10] 23+6** 

HBC (mainly), 
PBC, KSC 

30-39 3 [14] 47+12** 
40-49 3 [14] 66+14** 
50-59 3 [14] 73+9** 
60-69 2 [10] 107+4** 
70-79 2 [10] 52+2** 
80-89 1.5 [7] 16+2** 

Black Females 

18-29 2 [10] 8+2** 

HBC (mainly), 
PBC, KSC 

30-39 3 [14] 17+2** 
40-49 3 [14] 13+5** 
50-59 3 [14] 16+4** 
60-69 2 [10] 9+1** 
70-79 2 [10] 5+0 
80-89 1.5 [7] 0+1 

White Males 

18-29 2 [10] 1+0 

PBC, KSC 

30-39 3 [14] 1+1 
40-49 3 [14] 9+5** 
50-59 3 [14]* 22+6** 
60-69 2 [10]* 38+7** 
70-79 2 [10] 78+8** 
80-89 1.5 [7] 45+1** 

White Females 

18-29 2 [10] 2+0 

PBC, KSC 

30-39 3 [14] 0+0 
40-49 3 [14] 5+2 
50-59 3 [14] 10+1 
60-69 2 [10]* 28+5** 
70-79 2 [10]* 51+6** 
80-89 1.5 [7] 46+3** 

Coloured Males 

18-29 2 [10] 7 

KSC 

30-39 3 [14]* 29** 
40-49 3 [14] 51** 
50-59 3 [14] 41** 
60-69 2 [10] 37** 
70-79 2 [10]* 16** 
80-89 1.5 [7] 4 

Coloured 
Females 

18-29 2 [10] 12** 

KSC 

30-39 3 [14] 16** 
40-49 3 [14] 25** 
50-59 3 [14]* 19** 
60-69 2 [10]* 14** 
70-79 2 [10] 4 
80-89 1.5 [7] 3 

Total 99 [474] 
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*Take more from these cohorts to make up for the limited numbers from adjacent
cohorts
**Total required sample or exceeding sample sizes
***Currently the numbers do not include samples from SMU
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SOP 1.1. Selection of skeletal material for scanning 
N
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(1.0) PURPOSE & SCOPE: 

1) PURPOSE:

The purpose of this document is to describe the skeletal elements that will be selected for 
scanning as well as exclusion criteria for selection. These criteria will ensure that only the most 
complete and undamaged (not altered by pathology, healed trauma, or postmortem damage) 
skeletal elements will be selected for scanning and added to the Bakeng se Afrika digital 
skeletal repository. 

2) SCOPE:
This document and the guidelines herein will be used by skeletal collections managers or
curators as well as by any researchers scanning skeletal material that will be added to the
Bakeng se Afrika digital skeletal repository, including but not limited to the curator of the
Kirsten Collection (housed at the Stellenbosch University), the curator of the Pretoria Bone
Collection (housed at the University of Pretoria) and the curator of the Human Bone Collection
(housed at the Sefako Makgatho Health Sciences University).

(2.0) DEFINITION: 
The following terminology will be used throughout the standard operating procedures for 
skeletal element selection and the scanning procedures. Definitions are taken from The 
Human Bone Manual by T.D. White and P.A. Folkens (2005). 

• Skull: the bones of the head, including both cranium and mandible
• Mandible: lower jaw
• Cranium: the bones of the skull except for the mandible
• Calvaria: the cranium not including the face
• Calotte: the calvaria without the base
• Cranial vault: in this instance, the vault refers to the part of the calotte that is cut and

separated from the rest of the cranium during dissection, in order to remove the brain
• Dentition: the teeth
• Proximal: nearest to the axial skeleton
• Axial skeleton: bones of the trunk including the vertebrae, ribs and sternum
• Distal: opposite of proximal; farthest from the axial skeleton
• Epiphyses: the cap at the end of a long bone that develops from secondary ossification

centres
• Diaphysis: the shaft of the long bone
• Midshaft: the midpoint of the diaphysis (shaft of the bone)
• Pathological lesion: an injury or wound; an area of pathologically altered tissue
• Antemortem trauma/changes: alterations to the bone that occur before the death of an

individual (usually present with indicators of healing such as smoothed or rounded
edges)
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• Postmortem damage: damage that occurred to the bone after moisture was removed 
from the bone (damage to dry bone); usually associated with colour differences 
between the fracture edge and the bone surface 

• Postcrania: all bones except the cranium and mandible 
• Cancellous bone: spongy, porous lightweight bone found under protuberances where 

tendons attach, in vertebral bodies, in the neds of long bones, in short bones, and 
within flat bones (also called trabecular bone)  

• Cortical bone: the solid, dense bone that is found in the walls of bone shafts and on 
external bone surfaces (also called compact bone) 

• Femur: long bone of the thigh 
• Radius: one of the two long bones of the forearm – from elbow to wrist on the thumb 

side 

 

(3.0) ABBREVIATION LIST 
2D- Two dimensional 
3D- Three dimensional 
CT- computed tomography 
CBCT - Cone beam computed tomography 
DICOM - Digital Imaging and Communications in Medicine 
FOV - Field of view 
HEI - Higher Education Institutions 
KSC - Kirsten Skeletal Collection 
Micro-XCT - microfocus scanning computed tomography 
PI – Principle investigator 
VSD- Virtual Skeletal Database 
 

(4.0) ROLES AND RESPONSIBILITIES 

Collections managers/curators: 

• If the scanning of bones is linked to a research project, ensure that the relevant ethics 
consent has been provided to the researcher prior to handing the bones for scanning. 

• Provide database of appropriate bones in the skeletal collection from which to select 
the specimens for scanning. 

• Provide a maximum number of bones that can be taken for scanning at a time 

Researchers (if applicable): 

• Depending on the institution, check whether the relevant bones are suitable for 
scanning (i.e. check for any of the exclusion criteria and remove from the sample if 
necessary) 

• Ensure that skeletal material to be scanned will be handled with care by all involved to 
prevent any damages.  
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(5.0) BACKGROUND OF BAKENG SE AFRIKA PROJECT 
Stellenbosch University, along with the University of Pretoria (South Africa), Sefako Makgatho 
Health Sciences University (South Africa), the Nuclear Energy Corporation of South Africa 
(NECSA) (South Africa), the University of Bordeaux (France), the University of Coimbra 
(Portugal) and the Catholic University Leuven (Belgium) received funding from the Education, 
Audiovisual and Culture Executive Agency of the European Commission through the 
Erasmus+ Programme. This programme is the EU's mode to support education, training, youth 
and sport and it has opportunities for a wide variety of individuals and organisations. The 
University of Pretoria is the lead institution on the project and the project has been entitled 
“Bakeng se Afrika”.  
 

OBJECTIVE OF BAKENG SE AFRIKA 
The objective of Bakeng se Afrika is to develop and manage a comprehensive digital imaging 
collection of South Africans as a capacity-building resource for improvement in the 
internationalisation of Higher Education Institutions (HEI). This digital archive of images from 
various radiological modalities will be internationally accessible. The Kirsten Anthropology 
Research Unit as part of the Division of Clinical Anatomy at Stellenbosch University (SU) that 
houses the established Kirsten Skeletal Collection (KSC) is one of three skeletal collections 
to be used in this project. 
 

RADIOLOGICAL IMAGES AS OUTPUTS OF BAKENG SE AFRIKA 

• Outputs will impact teaching in HEI’S. The development of online curricula in the medical 
and health sciences are strongly dependent on imaging and digital data. 

• Outputs will impact research in HEI’s. Research will be done by postgraduate students, 
and thereby increase the capacity of universities to train professionals. Many researchers 
prefer using digital images when compared to other data sources due to the ease of 
accessibility, large sample size and its non-destructive nature. Furthermore, research will 
aid in creating new methodologies or validating those already in use. 

• Outputs will impact medico-legal investigations for deceased individuals. Forensic 
anthropologists’ role is to estimate the biological profile of deceased individuals whose 
remains are in advanced stages of decomposition, skeletonised, mutilated and burnt. To 
describe these biological parameters, skeletal collections of known individuals are needed 
as reference samples. To alleviate the effects of secular trends, ethical and religious 
issues, the need for physical storage space and the time-consuming process of 
maceration associated with having a physical skeletal collection, non-invasive radiological 
modalities are used, therefore a need to create virtual skeletal databases are pursued. 
Imaging is rapid and can be done without maceration of bones. This ensures that no 
information is lost and that the anatomical relationship of the bones is kept. 

• Business such as dental implant companies will also benefit from these digital collections. 
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MATERIAL TO BE SCANNED 
The dry-bone to be used in the proposed study will be from the Kirsten Skeletal Collection 
(KSC) that is currently housed in the FISAN building, room F219, Division of Clinical Anatomy, 
Stellenbosch University. The KSC is a repository for skeletal remains deriving from cadavers 
used allocated to this institution for research and teaching purposes. Skeletal elements used 
during research projects are returned to the KSC after completion of the study. All identification 
records of individuals are anonymised with skeletal numbers and personal records are 
unknown to the researchers. Additionally, no medical records of any of the skeletons are 
known to the Department or any of the researchers.  
 
The skeletal material from each of the skeletal collections (Kirsten Collection, Pretoria Bone 
Collection, SMU Skeletal Collection) will contribute a percentage towards the contents of the 
Bakeng se Afrika digital skeletal repository. As a variety of age groups, ancestry groups and 
sexes are necessary to create a holistic digital repository, each sex, ancestry and age group 
will make up a certain percentage of the repository. The total number of skeletons available 
for scanning determines the number of skeletons that correspond to the percentages; 
however, the total number can only be determined once all unsuitable skeletons, as 
determined by the exclusion criteria, have been removed from the total sample.  
 
 

Table 1.1. Percentage of each demographic group that will constitute the initial sample 
of the Bakeng se Afrika digital skeletal repository.  

Demographic 
profile 

Age 
cohort 

Approx. percent of 
repository (%) [approx. 
indiv. numbers] 

Maximum number 
available in cohort 
(PBC + KC)*** 

Collection(s) 

Bl
ac

k 
M

al
es

 

18-29 2 [10] 23+6** SMU 
(mainly), 
PBC, SU 

30-39 3 [14] 47+12** 
40-49 3 [14] 66+14** 
50-59 3 [14] 73+9** 
60-69 2 [10] 107+4** 
70-79 2 [10] 52+2** 
80-89 1.5 [7] 16+2** 

Bl
ac

k 
Fe

m
al

es
 

18-29 2 [10] 8+2** SMU 
(mainly), 
PBC, SU 

30-39 3 [14] 17+2** 
40-49 3 [14] 13+5** 
50-59 3 [14] 16+4** 
60-69 2 [10] 9+1** 
70-79 2 [10] 5+0 
80-89 1.5 [7] 0+1 

W
hi

te
 

M
al

es
 

18-29 2 [10] 1+0 PBC, SU 
30-39 3 [14] 1+1 
40-49 3 [14] 9+5** 
50-59 3 [14]* 22+6** 
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* take more from these cohorts to make up for the limited numbers from adjacent cohorts 
**Total required sample or exceeding sample sizes 
***Currently the numbers do not include samples from SMU  

 

(6.0) ETHICAL USE OF THIS DIGITAL DATA 

• Research on human skeletal remains is allowed and regulated by the: Human Tissues 
Act (No 65 of 1983), and National Health Act (No 61 of 2003). Ethical approval of the 
project has been obtained from the Health Research Ethics Committee, Stellenbosch 
University (S19/05/099).  

• Meta-data associated with images and personal information pertaining to the skeletal 
remains of individuals in the KSC should be removed or hidden from investigators to 
ensure anonymity.  

• The National Health Act makes provision for using these cadavers for 
teaching/research purposes, provided that some form of consent has been 

60-69 2 [10]* 38+7** 
70-79 2 [10] 78+8** 
80-89 1.5 [7] 45+1** 

W
hi

te
 F

em
al

es
 

18-29 2 [10] 2+0 PBC, SU 
30-39 3 [14] 0+0 
40-49 3 [14] 5+2 
50-59 3 [14] 10+1 
60-69 2 [10]* 28+5** 
70-79 2 [10]* 51+6** 
80-89 1.5 [7] 46+3** 

C
ol

ou
re

d 
M

al
es

 

18-29 2 [10] 7 SU 
30-39 3 [14]* 29** 
40-49 3 [14] 51** 
50-59 3 [14] 41** 
60-69 2 [10] 37** 
70-79 2 [10]* 16** 
80-89 1.5 [7] 4 

C
ol

ou
re

d 
Fe

m
al

es
 18-29 2 [10] 12** SU 

30-39 3 [14] 16** 
40-49 3 [14] 25** 
50-59 3 [14]* 19** 
60-69 2 [10]* 14** 
70-79 2 [10] 4 
80-89 1.5 [7] 3 

Total  99 [474]   
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documented. In circumstances where original (donor) consent and next of kin consent 
cannot be obtained, as is the case in this study for some individuals, legislation allows 
for the Inspector of Anatomy, as the representative of the Director-General, to provide 
proxy consent, provided that he/she is satisfied that attempts have been made to 
contact next of kin for consent.  

• All samples will be identified only by a coded identification number and only pertinent 
information of each patient will be captured, including age, sex, and self-identified 
population group as indicated on the records. No meta-data associated with images 
will be made available to the participant’s family. It is not expected that the study 
participant or their family will directly benefit in any way to this project. However, we 
note that this research study is likely to more generally benefit knowledge discovery. 
The findings will not affect the health status of any individual and will be used only for 
academic purposes.  

 

(7.0) SELECTION OF MATERIAL PROCEDURES 
The following skeletal elements will be assessed for each individual and if present and 
complete with limited damage (postmortem, antemortem or pathology), the individual can be 
added to the total sample for scanning: 
1) The mandible (in one piece – if cut or broken and can be reconstructed successfully using 

Prestick or masking tape (non-destructive) with minimal bone loss or distortion, the 
mandible can be used. If successful reconstruction is not possible, the bone must be 
excluded from the sample). If no teeth are present (postmortem or antemortem loss), the 
mandible can still be scanned, however, the scan for dentition will be excluded for the 
individual. 

2) The cranium (the cranial vault and the rest of the cranium need to be joined using Prestick 
or masking tape (non-destructive) so that the cranium is in one piece – if successful 
reconstruction is not possible – exclude from the sample). If no teeth are present 
(postmortem or antemortem loss) in the maxilla, the cranium can still be scanned, however, 
the scan for dentition will be excluded. 

3) The dentition – in order to scan the dentition a minimum of 8 teeth (at least 4 per maxilla 
and mandible) must be present, otherwise, the dentition should not be scanned. If at least 
eight teeth are present, the cranium and mandible can be considered for scanning dentition. 
Loose teeth should be placed back in the appropriate alveolar socket and held in place with 
masking tape. If the teeth cannot be replaced in the bone, the teeth are not counted towards 
the minimum of 8 teeth that need to be present for scanning. If no teeth/ not enough teeth 
are present (postmortem or antemortem loss), the cranium and mandible can still be 
scanned separately, but the scan for dentition should be excluded for the individual. If the 
teeth to be scanned are mostly replaced by metallic dental fillings, those teeth should not 
be included or counted as the minimum number of teeth required for scanning. 
Furthermore, if the metallic fillings are present in all teeth, the dentition should not be 
scanned, as the metal will create artefacts in the scans, which can interfere with the 
reconstruction and analysis of the scans.  
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4) The left* femur (any bones with healed fractures or extensive pathological conditions, as 
well as any bones demonstrating surgical interventions, such as prosthetics, screws and 
plates, should be excluded).  

5) The left* radius (any bones with healed fractures or extensive pathological conditions, as 
well as any bones demonstrating surgical interventions, such as prosthetics, screws and 
plates, should be excluded). 

*Note: for long bones, the left side is typically used; however, if the left is absent or has been 
excluded, then the right side may be used instead. If neither left nor right is available, then that 
bone will simply be excluded from the scans for that individual. 
 

(8.0) SURETY: 
Quality is provided in the peer review process VISUN Laboratory Manual, Part III, SOP 3.1 
(Peer Review). If deficiencies in images are noted, the primary analyst will ensure that images 
are retaken appropriately. Forensic imaging is also subject to audits VISUN Laboratory 
Manual, Part III, SOP 3.3 (Audits).  
 

(9.0) AVAILABILITY 
The original signed version of this document is kept by the Curator of the Kirsten Skeletal 
Collection. Training documents available in personnel folders. A copy of the document can be 
found on the document management system ALFRESCO. 

(10.0) DOCUMENT HISTORY 
 

Version 
No. 

Date   Location of Change History Author/ 
Reviewer 

Approving 
Official 

Date 
Approved  

Next Review 
Date 

1.0 20 Nov 
2019 

 A Alblas   2020 
 

 

(11.0) SUPPORTING DOCUMENTS 
Appendix 1 
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SOP 1.2. Transportation of skeletal material to scanning facility 
UP and SMU 

(1.0) Purpose 

The purpose of this document is to describe the procedure for the transportation of skeletal 
material for scanning at NECSA or any other scanning facility for addition to the Bakeng se 
Afrika digital skeletal repository.  

(2.0) Scope 

This document and the guidelines herein will be used by skeletal collections managers or 
curators as well as by any researchers or contractors transporting skeletal material that will 
be added to the Bakeng se Afrika digital skeletal repository. This includes but is not limited 
to the curator of the Kirsten Skeletal Collection (KSC, housed at the Stellenbosch 
University), the curator of the Pretoria Bone Collection (PBC, housed at the University of 
Pretoria) and the curator of the Human Bone Collection (HBC, housed at the Sefako 
Makgatho Health Sciences University) or any researchers or contractors tasked with 
transporting skeletal material to NECSA or any other scanning facility. 

(3.0) Definitions 

For definition of the terminology used in the current document, see SOP 1.1. 

(4.0) Roles and Responsibilities 

Collections managers/curators:  

• Make sure all skeletal material is labelled clearly and correctly to alleviate any chance
of mixing up of skeletal material from different individuals.

• Pack bones securely for transport
• Provide a permission letter for transport that includes the specimen numbers and the

bones that will be transported

Researchers/contractors (if applicable): 

• Depending on institution, pack bones securely for transport
• Make sure the appropriate permission letter is present and correct for the

transportation of skeletal material

(5.0) Procedures 

All skeletal material that will be transported to NECSA or any other scanning facility will 
need to be packed tightly and securely so as to limit any potential damage to the material 
during transportation. Cardboard or plastic boxes lined with bubble wrap make adequate 
transportation containers and can typically hold multiple bones at a time. A permission letter 
for transportation is necessary to be able to remove bones from campus and to make sure a 
complete list of specimens is available to check upon return of the skeletal material to the 
collections.  

(6.0) Appendix 
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Example of a permission letter for transportation of skeletal material from the Pretoria Bone 
Collection, housed in the Department of Anatomy, University of Pretoria.  

LETTER 

Date 

Dear [Name of researcher transporting bones] 

The Use of Human Skeletal Material from the Department of Anatomy, University of 
Pretoria for microCT scanning at NECSA  

You are hereby granted the temporary use of the following skeletal remains, which are 

permanently housed in the Pretoria Bone Collection in the Department of Anatomy at the 

University of Pretoria: 

● CadNrX ± cranium and mandible

● CadNrY ± left femur

● CadNrZ ± left radius

Under no circumstances may bone samples be taken. The Department of Anatomy requests 

that the skeletal material is to be kept in a locked room until the time of examination, and that 

it is returned to the Department of Anatomy within an acceptable time period.  

Sincerely, 

________________________________ 
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SOP 1.2. Transportation of skeletal material to scanning facility 
N
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(1.0) PURPOSE & SCOPE: 

1) PURPOSE: 

The purpose of this document is to describe the procedure for the transportation of skeletal 
material for scanning at NECSA, X-sight, or any other scanning facility for addition to the 
Bakeng se Afrika digital skeletal repository. 
 
2) SCOPE: 
This document and the guidelines herein will be used by skeletal collections managers or 
curators as well as by any researchers scanning skeletal material that will be added to the 
Bakeng se Afrika digital skeletal repository, including but not limited to the curator of the 
Kirsten Collection (housed at the Stellenbosch University), the curator of the Pretoria Bone 
Collection (housed at the University of Pretoria) and the curator of the Human Bone Collection 
(housed at the Sefako Makgatho Health Sciences University) or any researchers or 
contractors tasked with transporting skeletal material to NECSA, X-sight, or any other 
scanning facility. 
 

(2.0) DEFINITION: 
For the definition of the terminology used in the current document, see 
BsA.SOP.IMAGING.001: Selection of skeletal material for scanning. 

(3.0) ABBREVIATION LIST 
For a list of abbreviations used in the current document, see BsA.SOP.IMAGING.001: 
Selection of skeletal material for scanning. 
 

(4.0) ROLES AND RESPONSIBILITIES 

All staff and students 

• Be aware of the correct operating and maintenance procedures of the imaging 
methodology used. No person will be allowed to operate any equipment without prior 
training and/or certification. 

Collections managers/curators: 

• If the scanning of bones is linked to a research project, check that the relevant consent 
has been provided to the researcher prior to handing the bones for scanning. 

• Provide a database of appropriate bones in the skeletal collection from which to select 
the specimens for scanning. 

• Provide a maximum number of bones that can be taken for scanning at a time. 
• Make sure all skeletal material is labelled clearly and correctly to alleviate any chance 

of mixing up of skeletal material from different individuals. 
• Pack bones securely for transport 
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• Provide a permission letter for transport that includes the specimen numbers and the 
bones that will be transported. 

Researchers (if applicable): 

• Depending on the institution, check whether the relevant bones are suitable for 
scanning (i.e. check for any of the exclusion criteria and remove from the sample if 
necessary) 

• Ensure the correct consent has been given to transport, store and scan all skeletal 
material.  

• Ensure that once they skeletal material is scanned that it is returned to the correct box 
with the corresponding AN number.  

• Ensure that skeletal material to be scanned will be handled with care by all involved to 
prevent any damages.  

• Depending on institution, pack bones securely for transport 
• Make sure the appropriate permission letter is present and correct for the 

transportation of skeletal material 
•  

 

(5.0) TRANSPORT OF MATERIAL PROCEDURES 
 
All skeletal material that will be transported to scanning facilities will be packed tightly and 
securely so as to limit any potential damage to the material during transportation. Cardboard 
or plastic boxes lined with bubble wrap make adequate transportation containers and can 
typically hold multiple bones at a time and ensure that the skeletal material is not visible to the 
public while transported.  
A permission letter for transportation is necessary to be able to remove bones from campus 
and to make sure a complete list of specimens is available to check upon return of the skeletal 
material to the collections. 
The Inspector of Anatomy will approve transport of skeletal material to scanning modalities. 
During transportation, the letter of consent from the Inspector of Anatomy will remain with the 
samples. 
Storage of the skeletal material while scanning will be secured in a locked cabinet at the 
radiological facility, the skeletal material will remain covered unless it is being scanned. 

(6.0) SURETY: 
Quality is provided in the peer review process VISUN Laboratory Manual, Part III, SOP 3.1 
(Peer Review). If deficiencies in images are noted, the primary analyst will ensure that images 
are retaken appropriately. Forensic imaging is also subject to audits VISUN Laboratory 
Manual, Part III, SOP 3.3 (Audits).  
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(7.0) AVAILABILITY 
The original signed version of this document is kept by the Curator of the Kirsten Skeletal 
Collection. Training documents available in personnel folders. A copy of the document can be 
found on the document management system ALFRESCO. 

(8.0) DOCUMENT HISTORY 
 

Version 
No. 

Date   Location of Change History Author/ 
Reviewer 

Approving 
Official 

Date 
Approved  

Next Review 
Date 

1.0 20 Nov 
2019 

 A  Alblas   2020 
 

 

(9.0) SUPPORTING DOCUMENTS 
Appendix 1: Example of permission letter for transport of skeletal material from the KSC, 
housed at the Division of Anatomy, Stellenbosch University. 
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Date 

Dear [Name of researcher transporting bones] 

The Use of Human Skeletal Material from the Division of Anatomy, Stellenbosch 
University for microCT scanning at NECSA  

You are hereby granted the temporary use of the following skeletal remains, which are 

permanently housed in the Kirsten Skeletal Collection in the Division of Anatomy at 

Stellenbosch University: 

• CadNrX – cranium and mandible

• CadNrY – left femur

• CadNrZ – left radius

Under no circumstances may bone samples be taken. The Division of Anatomy requests that 

the skeletal material is to be kept in a locked room until the time of examination and that it is 

returned to the Division of Anatomy within an acceptable time period.  

Sincerely, 

________________________________ 
A Alblas  

Curator: Kirsten Skeletal Collection 
Department of Biomedical Sciences 
Faculty of Medicine and Health Sciences 
Stellenbosch University 
Tel:  021 938 9394 
Cell:  0825771645 
Email: aa2@sun.ac.za 
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SOP 1.3. Bone preparation before scanning 
UP and SMU 

(1.0) Purpose 

The purpose of this document is to detail the bone preparations and pre-scan procedures to 
be completed when preparing crania for scanning for addition to the Bakeng se Afrika digital 
skeletal repository.   

(2.0) Scope 

This document and the guidelines herein will be used by skeletal collections managers or 
curators, researchers, contractors and/or the individuals responsible for preparing the skeletal 
elements for scanning once the material is at the scanning facility (NECSA/ other scanning 
facility).  

(3.0) Definitions 

For definition of the terminology used in the current document, see SOP 1.1. 

(4.0) Roles and Responsibilities 

The preparation of the skeletal elements for scanning, which includes replacing teeth and 
reconstructing the cranial vault with the rest of the cranium will be completed by the curator, 
researcher or contractor that brought the skeletal material for scanning. The stabilisation of 
the bones within the scanner will be the responsibility of the person tasked with operating the 
micro-XCT scanner at NECSA/ any other scanning facility.   

(5.0) Procedures 

• Crania

If the cranium is not already whole or if this was not already completed prior to 
transportation, the cranium needs to be reconstructed using Prestick or masking tape (non-
destructive) to attach the cranial vault to the rest of the cranium. Any loose maxillary teeth 
should be taped into their appropriate alveolar sockets in the maxilla using Prestick or 
masking tape (non-destructive). 

Once the cranium is in one piece, with the help of the scientists of the scanning facility, the 
skeletal element will need to be stabilised using styrofoam, polystyren or cardboard 
(materials that have completely different densities to bone) within the scanner. These 
materials have no influence on the scanned data due to their low-density nature. 

• Mandibles

If the mandible is not already whole or if this was not already completed prior to 
transportation, the mandible needs to be reconstructed using Prestick or masking tape (non-
destructive) to attach the pieces of the mandible together. Any loose mandibular teeth should 
be taped into their appropriate alveolar sockets in the mandible using Prestick or masking 
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tape (non-destructive). 

Once the mandible is in one piece and all teeth are replaced in the bone, the mandible will 
need to be stabilised using Styrofoam or cardboard (materials that have completely different 
densities to bone) within the scanner. These materials have no influence on the scanned data 
due to their low-density nature.  

• Focus on dentition

The cranium does not need to be reconstructed for the scanning of the maxillary dentition. 
With the help of the scientists of the scanning facility, the maxilla will need to be stabilised 
using styrofoam, polystyren or cardboard (materials that have completely different densities 
to bone) within the scanner. These materials have no influence on the scanned data due to 
their low-density nature. 

Figure 2. Image illustrating maxillary dentition and the directional terminology 
associated with dentition. 

• Femora

With the help of the scientists of the scanning facility, the femur will need to be positioned 
vertically and stabilised using styrofoam, polystyren or cardboard (materials that have 
completely different densities to bone) within the scanner. These materials have no influence 
on the scanned data due to their low-density nature. 

Because the femora are too large to scan in one part at an adequate resolution, the bone will 
need to be scanned in three parts: the proximal end, the diaphysis and the distal end 
respectively named A, B and C, which can then be merged. A small portion of the proximal 
part will be visible in the scan of the shaft, and a small portion of the shaft part will be also 
scanned with the distal part. Small pieces of Prestick or clay will need to be placed on the 
proximal one-third and on the distal one-third of the diaphysis so that during the 
reconstruction/stitching/merging phase, those areas can be recognised and overlapped to 
reconstruct the entire femur accurately. 

In addition, when possible, for each femur, a focus will be made on the proximal and distal 
epiphyses. 
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Two femora can be scanned together. Therefore, in order to be able to identify the femora in 
the virtual images, another marker made of Prestik will be placed in one of the two femora. 

• Radii

With the help of the scientists of the scanning facility, the radii will need to be positioned 
vertically and stabilised using styrofoam, polystyren or cardboard (materials that have 
completely different densities to bone) within the scanner. These materials have no influence 
on the scanned data due to their low-density nature. 

Because the radii are too large to scan in one part at an adequate resolution, the bones will 
need to be scanned in two parts: the proximal halves and the distal halves, respectively named 
A and B, which can then be merged. A small portion of the proximal part will be visible in 
the scan of the distal part. Therefore, in order to be able to identify the parts in the virtual 
images, a small piece of Prestick or clay will need to be placed at the level of the middle of 
the diaphysis so that during the reconstruction/stitching/merging phase, that area can be 
recognised and overlapped to reconstruct the entire radius accurately. 

Two radii can be scanned together. Therefore, in order to be able to identify the radii in the 
virtual images, another marker made of Prestik will be placed in one of the two radii. 

PAGE SIGNATURES 
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(1.0) PURPOSE & SCOPE: 

1) PURPOSE: 

The purpose of this document is to detail the bone preparations and pre-scan procedures to 
be completed when preparing various skeletal elements for scanning for addition to the 
Bakeng se Afrika digital skeletal repository.  
 
2) SCOPE: 
This document and the guidelines herein will be used by skeletal collections managers or 
curators as well as by any researchers scanning skeletal material that will be added to the 
Bakeng se Afrika digital skeletal repository, including but not limited to the curator of the 
Kirsten Collection (housed at the Stellenbosch University), the curator of the Pretoria Bone 
Collection (housed at the University of Pretoria) and the curator of the Human Bone Collection 
(housed at the Sefako Makgatho Health Sciences University) or any researchers or 
contractors and/or the individuals responsible for preparing the skeletal elements for scanning 
once the material is at the scanning facilities. 

(2.0) DEFINITION: 
For the definition of the terminology used in the current document, see BsA.SOP.IMAGE.001: 
Selection of skeletal material for scanning. 

(3.0) ABBREVIATION LIST 
For a list of abbreviations used in the current document, see BsA.SOP.IMAGE.001: Selection 
of skeletal material for scanning. 
 

(4.0) ROLES AND RESPONSIBILITIES 

All staff and students 

• Be aware of the correct operating and maintenance procedures of the imaging 
methodology used. No person will be allowed to operate any equipment without prior 
training and/or certification. 

Collections managers/curators/contractors: 

• The preparation of the skeletal elements for scanning, which includes replacing teeth 
and reconstructing the cranial vault with the rest of the cranium will be completed by 
the curator, researcher or contractor that brought the skeletal material for scanning.  

Scanning technician/radiographer: 

• Check whether the relevant bones are suitable for scanning. 
• Ensure that once they skeletal material is scanned that it is returned to the correct box 

with the corresponding AN number.  
• Ensure that skeletal material to be scanned will be handled with care by all involved to 

prevent any damages.  
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• The stabilisation of the bones within the scanner will be the responsibility of the person 
tasked with operating the micro-XCT scanner at the scanning facility.  

 

(5.0) PREPARATION OF MATERIAL FOR SCANNING 
Micro-XCT is taken at X-Sight™ X-Ray Services (Unit 2, Gable Business Park, 10 Derrick 
Drive, Somerset West, 7130), using a Nikon XT H225 ST Micro-CT scanner or at the South 
African Nuclear Energy Corporation (NECSA) (Elias Motosaeledi Street Extension, 
R104 Pelindaba, Madibeng Municipality, North West Province, 0240). 
 
The following procedures for scanning of skeletal elements are specifically for the MicroCT-
scanning facility at NECSA. 
 

1) CRANIUM 
If the cranium is not already whole or if the different bones of the skull was not already 
completed before transportation, the cranium needs to be reconstructed using Prestick or 
masking tape (non-destructive) to attach the cranial vault to the rest of the cranium. Any loose 
maxillary teeth should be taped into their appropriate alveolar sockets in the maxilla using 
Prestick or masking tape (non-destructive). Once the cranium is in one piece, the skeletal 
element will need to be stabilised using Styrofoam or cardboard (materials that have 
completely different densities to bone) within the scanner. 
 

2) MANDIBLE 
If the mandible is not already whole or if this was not already completed prior to transportation, 
the mandible needs to be reconstructed using Prestick or masking tape (non-destructive) to 
attach the pieces of the mandible. Any loose mandibular teeth should be taped into their 
appropriate alveolar sockets in the mandible using Prestick or masking tape (non-destructive). 
Once the mandible is in one piece and all teeth are replaced in the bone, the mandible will 
need to be stabilised using Styrofoam or cardboard (materials that have completely different 
densities to bone) within the scanner. 
 

3) DENTITION 
See above for reconstruction and preparation of the mandible for scanning. The cranium does 
not need to be reconstructed for the scanning of the dentition; however, if this is already 
completed for a different scan then the reconstructed cranium can be used. For the scanning 
of the dentition, the mandible and cranium need to be articulated with the mandibular condyles 
(Fig 3.1) fitting into the mandibular fossae (Figure 3.2) and the occlusal surfaces of the teeth 
fitting together where possible (Figure 3.4). Once the cranium and mandible are appropriately 
articulated, the bones will need to be stabilised using Styrofoam or cardboard or clay 
(materials that have completely different densities to bone) within the scanner. 
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Figure 3.1. Mandible with the mandibular condyles highlighted. 
 

 
Figure 3.2. Articulated mandible and cranium. 
 

 
Figure 3.3. The inferior aspect of the cranium illustrating the mandibular fossa where the 
mandible articulates (highlighted) 
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Figure 3.4. Image illustrating maxillary dentition and the directional terminology associated 
with dentition. 
 

4) FEMORA 
Because the femora are too large to scan in one part at an adequate resolution, the bone will 
need to be scanned in three parts, the proximal end, the diaphysis and the distal end. In order 
to be able to reconstruct the separate scans to create scans that include the entire femur, two 
areas will need to be demarcated on the bones using Prestick or clay. Small pieces of the 
Prestick or clay will need to be placed on the proximal one-third and the distal one-third of the 
diaphysis so that during the reconstruction phase, those areas can be recognised and 
overlapped to reconstruct the femur accurately.  The marked areas indicate up until where the 
different scans should be taken. Therefore, when the femur is scanned for the first time, the 
proximal end up until the marker (Prestick or clay on the proximal one-third of the diaphysis) 
should be the focus of the scan, whereas the second scan should focus on the part of the 
diaphysis between the two markers (on the proximal and distal on-thirds, respectively). The 
third and final scan should focus on the distal part of the femur from the marker on the distal 
one-third of the diaphysis to the distal end of the femur. The resolutions, and therefore the 
sizes of the parts scanned, should be as equal as possible for the three parts of the femur. 
The femur will need to be stabilised within the scanner using Styrofoam, cardboard or clay.  
 
 

5) RADII 
Because the radii are too large to scan in one part at an adequate resolution, the bones will 
need to be scanned in two parts, the proximal halves and the distal halves. In order to be able 
to reconstruct the separate scans to create scans that include an entire radius, the midpoint 
of the bone will need to be demarcated using Prestick or clay. A small piece of the Prestick or 

Occlusal surface 
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clay will need to be placed at the level of the middle of the diaphysis so that during the 
reconstruction phase, that area can be recognised and overlapped to reconstruct the radius 
accurately. The marked areas also indicate up until where the different scans are to be taken. 
Therefore, when the radius is scanned for the first time, the proximal end up until the midpoint 
marker (Prestick or clay at the midpoint of the diaphysis) should be the focus of the scan, 
whereas the second scan should focus on the distal part of the radius from the marker on at 
midpoint to the distal end of the radius. The resolutions, and therefore the sizes of the parts 
scanned, should be as equal as possible for the two parts of the radius. The radius will need 
to be stabilised within the scanner using Styrofoam, cardboard or clay. 
 

6) RIBS 
Left and right ribs are scanned separately and are rolled in bubble wrap and separated by 
cardboard sheets. This is to ensure that ribs do not come into contact with one another, as 
this complicates post-processing and the separation of elements.  Each radiograph is labelled 
according to the AN number of the sample, as well as the anatomical region being scanned. 
During post-processing, individual skeletal elements may be exported and labelled 
accordingly. 
 

 

 

Figure 5.1: Ribs placed and wrapped in 
preparation for scanning. 

Figure 5.2: Ribs mounted within bubble 
wrap, separated by cardboard. 

 
With a larger detector, like the one at NECSA, the left and right ribs can be scanned together. 
The ribs are ordered from one to twelve and packed out on the top 4 sheets of A2 art foam. 
The ribs are placed in anatomical position (e.g. Left first rib and right first rib next to each other 
with the head of the rib at the same end). The sheets are folded and packed so that the ribs 
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are in ascending order. Masking tape is wrapped around the four folded sheets to secure it in 
place and to ensure no movement during the scanning process.   
 
 
7) VERTEBRAE 
Vertebrae are scanned in ascending order from C1 to T12. The vertebra are stacked in 
sections, number of vertebra dependant on the field of view. The vertebra are either placed in 
Styrofoam (as scanned at Necsa) or the vertebrae are stacked on a rod  (Fig. 6.1) with 
carboard separating each vertebra (Fig. 6.2) (as scanned at X-Sight). This is done to ensure 
that the vertebrae do not come in contact with one another, as this complicates post-
processing and the separation of elements. The mounted vertebrae are then attached to the 
rotating table within the Micro XCT scanner.  
 
 

 

 

Figure 6.1: Mounting apparatus for the 
radiological scan of vertebrae. 

Figure 6.2: Lumbar vertebrae mounted on 
the stand with foam separators 

 

 (6.0) SURETY: 
Quality is provided in the peer review process VISUN Laboratory Manual, Part III, SOP 3.1 
(Peer Review). If deficiencies in images are noted, the primary analyst will ensure that images 
are retaken appropriately. Forensic imaging is also subject to audits VISUN Laboratory 
Manual, Part III, SOP 3.3 (Audits).  
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(7.0) AVAILABILITY 
The original signed version of this document is kept by the Curator of the Kirsten Skeletal 
Collection. Training documents available in personnel folders. A copy of the document can be 
found on the document management system ALFRESCO. 

(8.0) DOCUMENT HISTORY 
 

Version 
No. 

Date   Location of Change History Author/ 
Reviewer 

Approving 
Official 

Date 
Approved  

Next Review 
Date 

1.0 20 Nov 
2019 

 A Alblas   Dec 2020 
 

2.0 Jan 2020 Revised M Middleton 
R Pieterse 

A Alblas Mar 2020 2021 
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SOP 2. SCANNING PROCEDURES 

SOP 2.1. Scanning modalities 
UP, SMU and SUN 

(1.0) Purpose 

The purpose of this document is to detail the scanning procedures possibly performed for the 
Bakeng se Afrika digital skeletal repository.   

(2.0) Scope 

This document and the guidelines herein will be used by skeletal collections managers or 
curators, researchers, contractors and/or the individuals responsible for preparing the skeletal 
elements for scanning once the material is at the scanning facility (NECSA/ other scanning 
facility).  

(3.0) Definitions 

For definition of the terminology used in the current document, see SOP 1.1. 

(4.0) Roles and Responsibilities 

All staff and students: 

• Be aware of the correct operating and maintenance procedures of the imaging
methodology used. No person will be allowed to operate any equipment without prior
training and/or certification.

Collections managers/curators/contractors: 

• The preparation of the skeletal elements for scanning, which includes replacing teeth
and reconstructing the cranial vault with the rest of the cranium will be completed by
the curator, researcher or contractor that brought the skeletal material for scanning.

Scanning technician/radiographer: 

• Check whether the relevant bones are suitable for scanning
• Ensure that once they skeletal material is scanned that it is returned to the correct box

with the corresponding collection number.
• Ensure that skeletal material to be scanned will be handled with care by all involved

to prevent any damages.
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(1.0) PURPOSE & SCOPE: 

1) PURPOSE: 

The purpose of this document is to detail the bone preparations and pre-scan procedures to 
be completed when preparing various skeletal elements for scanning for addition to the 
Bakeng se Afrika digital skeletal repository.  
 
2) SCOPE: 
This document and the guidelines herein will be used by skeletal collections managers or 
curators as well as by any researchers scanning skeletal material that will be added to the 
Bakeng se Afrika digital skeletal repository, including but not limited to the curator of the 
Kirsten Collection (housed at the Stellenbosch University), the curator of the Pretoria Bone 
Collection (housed at the University of Pretoria) and the curator of the Human Bone Collection 
(housed at the Sefako Makgatho Health Sciences University) or any researchers or 
contractors and/or the individuals responsible for preparing the skeletal elements for scanning 
once the material is at the scanning facilities. 

(2.0) DEFINITION: 
For definition of the terminology used in the current document, see BsA.SOP.IMAGE.001: 
Selection of skeletal material for scanning. 

(3.0) ABBREVIATION LIST 
For a list of abbreviations used in the current document, see BsA.SOP.IMAGE.001: Selection 
of skeletal material for scanning. 
 

(4.0) ROLES AND RESPONSIBILITIES 

All staff and students 

• Be aware of the correct operating and maintenance procedures of the imaging 
methodology used. No person will be allowed to operate any equipment without prior 
training and/or certification. 

Collections managers/curators/contractors: 

• The preparation of the skeletal elements for scanning, which includes replacing teeth 
and reconstructing the cranial vault with the rest of the cranium will be completed by 
the curator, researcher or contractor that brought the skeletal material for scanning.  

Scanning technician/radiographer: 

• Check whether the relevant bones are suitable for scanning 
• Ensure that once they skeletal material is scanned that it is returned to the correct box 

with the corresponding AN number.  
• Ensure that skeletal material to be scanned will be handled with care by all involved to 

prevent any damages.  

47



• The stabilisation of the bones within the scanner will be the responsibility of the person 
tasked with operating the microCT scanner at the scanning facility.  

•  
 

(5.0) GENERAL OPERATION OF IMAGE EQUIPMENT: 

• This SOP does not detail the specific operator’s manual for each modality. For detailed 
instructions for each modality used, refer to specific Operating Procedures. 

• Always decontaminate image modalities after use. 
• Equipment should always be washed and sterilized after use to avoid contamination 

or infection. 
 

(6.0) SCANNING MODALITIES: 

• Always refer to specific operator’s manual and maintenance procedure of each 
imaging modality for detailed instructions. 

These modalities may include: 

o X-Rays 
o Computed tomography (CT-scans) 
o Microfocus scanning (Micro-XCT),  
o Magnetic resonance technical aspects of imaging (MRI) 
o Lodox Statscan 
o Cone beam (CBCT) 
o Medtronics O-arm 
o cephalograms 

1) X-RAYS  
X-rays were first discovered in 1895 by Wilhelm Conrad Roentgen and three years following 
its use in the clinical setting; rather it was used in the examination of a dead body (Griffith and 
Genant, 2011; Franklin et al., 2016). It allows for the external and internal visualization of bone, 
eliminating the need for the body to be dissected (Franklin et al., 2016). X-rays in the field of 
forensic medicine, are commonly used in helping find projectiles in ballistic investigations and 
to identify bone fractures (Bolton, 2011; Kučerová et al., 2014). They are seen as the golden 
standard method in victim identification (Kučerová et al., 2014).  This technique provides 
excellent resolution and can differentiate bone boundaries (Mehta et al., 1997). X-rays make 
use of ionising radiation and thus emit electromagnetic radiation, which is harmful to patients 
and operators (Franklin et al., 2016). Its use within the forensic field is not practical as multiple 
scans are required to obtain a full-body image (Bolton, 2011). This technique displays 
difficulties in truly representing the dimensions of bone as the images obtained are often 
distorted (Maresh, 1955). It is described to be time-consuming and labour intensive (Deyle et 
al., 2009). Following, the discovery of the X-ray, another technique which too uses ionizing 
radiation was created; computed tomography (CT) (Hounsfield, 1973; Kalender, 2011).  
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COMPUTED TOMOGRAPHY (CT)  
Computed Axial Tomography (CAT) or Computed Tomography (CT) is an imaging modality 
that records 2-dimensional (2D) x-ray images from various angles around an object of interest. 
These 2D images are then reconstructed into a 3-dimensional (3D) volume. This allows for 
multidirectional examination of regions of interest, as well as dimensional, volumetric, and 
other advanced measurements. 
This imaging modality was created by an English engineer, G.N Hounsfield in 1972 and first 
used in a clinical setting in 1975 (Hounsfield, 1973; Kalender,2011). It produces cross-sections 
of bone with high visibility contrast between various soft tissues, greater than X-rays, in 
addition to having a rapid processing time (Mehta et al., 1997; Stull et al., 2014). Both, the 
shape and size of bone can be determined from a CT scan (Franklin et al., 2016). The 
osteological measurements collected from CT-scans have also been shown to be similar to 
dry bone specimens (Franklin et al., 2013; Stull et al., 2014; Lorkiewicz-Muszynska et al, 
2015). CT scans are capable of replacing skeletal collections, supported by studies conducted 
on its use in estimating biological profiles (Schmeling et al., 2004; Schulz et al., 2005; Franklin 
et al., 2012; Zech et al., 2012; Franklin et al., 2014; Franklin & Flavel, 2015; Mehta et al., 2015; 
Torimitsu et al., 2016).  
 
Microfocus scanning (Micro-XCT) 
Industrial CT, often referred to as Micro-CT, is designed for industrial applications, but may 
also be used in biological applications. Micro-CT utilizes a penetrating ionising radiation (x-
ray) source and detector to obtain 2D images of an object that may then be reconstructed into 
a 3D image. The source and detector are fixed around a rotating sample, allowing for the 
adjustment of image resolution Micro-CT are also more flexible in terms of voltage and current 
modification, which allows for the setup to be modified to suit various materials. The image 
resolution of Micro-CT scans is often higher than their biomedical counterparts, with image 
resolution generally in the range of 5-150 micrometres (μm). Scans have advantages over 
physical specimens, in that measurements are not limited to external anatomy, and that 
measurements obtained from the software are of high precision.  
 
Micro-CT utilises an x-ray source and detector, which are fixed around a rotating sample, 
allowing for the adjustment of image resolution. Micro-CT uses an x-ray source and detector 
to obtain 2D images of an object that may then be reconstructed into a 3D image. The 
fundamental components of the machine include penetrating ionising radiation, a sample 
manipulator (in this case a rotation table), and a detector. A micro-focus x-ray tube uses a 
beam of voltage-accelerated electrons, which are focused onto a metal (generally tungsten) 
target. The interaction between the accelerated electrons and the metal target is responsible 
for the generation of x-rays. The x-rays are directed around and through the sample and 
collected in the form of a projection image (or radiograph) on a 2D x-ray detector. The sample 
manipulator positions the sample in the path of the radiation beam and rotates it through a 
specified angle (mostly 180° or 360°). The detector converts the attenuated radiation, which 
is directed in a straight line through the sample, into 2D digital images, made up of thousands 
of pixels. Two-dimensional projection images numbering in the hundreds to thousands are 
thus recorded during scanning. 
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These 2D images are then used to reconstruct a 3D data set using filtered back-projection 
algorithms. In this way, every volumetric pixel (or voxel) is guidance in the selection of what 
should be imaged from many angles by 2D projections. The sum of views from each angle 
thus creates a representation of the actual x-ray density, and thus the brightness, of a specific 
voxel.  
 
 
3) MAGNETIC RESONANCE IMAGING (MRI) 
This safer technique, subjects the body to a strong magnetic frequency, followed by a 
radiofrequency instead of emitting electromagnetic radiation (Mehta et al., 1997; Franklin et 
al., 2016). It can acquire images in any plane and can derive information from both the bone 
and bone marrow, which is not possible with other image modalities (Griffith and Genant, 
2011). Studies have validated the accuracy and precision of long bone measurements 
collected from MRI’s (Leitzes et al., 2005; Doyle & Winsor, 2011; Rathnayaka et al., 2012). In 
addition to the studies which focussed on estimating certain biological profiles from MRI scans 
(Dedouit et al., 2012; Saint-Martin et al., 2013; Brits et al., 2017).  
 
4) LODOX STATSCAN 
The Lodox Statscan is housed in the Tygerberg Forensic Pathology Services Mortuary at 
Tygerberg Hospital. It is a full-body digital X-ray machine, designed and manufactured by a 
South African company, Lodox Systems. The technique was designed to produce high quality, 
low dosage, 2D images in approximately 10-13 seconds. In South Africa, Lodox Statscans are 
available and in use within the mortuaries found in the Western Cape, Cape Town, Pretoria 
and Johannesburg Forensic Pathology Services. Where it is used to locate foreign objects 
such as firearm projectiles in deceased individuals and in detecting peripheral skeletal injuries. 
The scans are stored in a DICOM® image format and will be transferred to Image J® 1.4r 
imaging software prior to measuring.  
Unlike the above-mentioned virtual modalities, the Lodox Statscan (Lodox® Systems Pty., 
Sandton, South Africa) was primarily designed and used in diamond-mines to prevent theft 
within the workplace (Boffard, 2006). Lodox Statscan is a full-body digital X-ray machine, 
designed and manufactured by a South African company, Lodox Systems (Bolton, 2011). The 
technique was designed to produce high quality, low dosage, 2D images in approximately 10-
13 seconds (Beningfield et al., 2003; Bolton, 2011; Stull et al., 2013). The scanner was custom 
designed to suit the wet laboratory conditions in the mortuary (Bateman, 2008). Lodox 
Statscans have been used in identifying foreign objects within the body of deceased 
individuals (Knobel et al., 2006; Deyle et al., 2010; Evangelopoulos et al., 2011; Fu et al., 
2011). In South Africa, Lodox Statscans are available and in use within the mortuaries found 
in the Western Cape, Cape Town (Alblas et al., 2018), Pretoria (Bernitz & Verster, 2017) and 
Johannesburg Forensic Pathology Services. Where it is used to locate foreign objects such 
as firearm projectiles in deceased individuals and in detecting peripheral skeletal injuries 
(Knobel et al., 2006; Bernitz & Verster, 2017). Its benefits include; accelerating investigations, 
victim identification and its contribution to the VSD (Bateman, 2008; Bernitz & Verster, 2017) 
and the ultimate disposition of images.  
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Figure 1: The Lodox Statscan housed at Tygerberg Forensic Pathology Services. 

 
 

5) MEDTRONIC O-ARM® 

The Medtronic O-arm® surgical imaging system is housed in the SUNSkills lab, FISAN 
building, third floor. It is a two-dimensional (2D) fluoroscopic and three-dimensional (3D) 
volumetric mobile imaging system that uses ionising-radiation to produce a radiograph. 
“Fluoroscopic” refers to X-radiation passing through the body or skeletal element and forming 
The 3D scan produced by the O-arm® is a cylindrical tube with a 40 cm diameter and 15 cm 
height. Two-dimensional images can be obtained through fluoroscopy producing a 40 cm x 40 
cm scan. It takes the O-arm® 13 seconds to scan the desired object/material/patient in 3D 
and 30 seconds to form the image. Two-dimensional images are formed almost 
instantaneously. 

The images produced by the O-arm® may be two- (2D) or three-dimensional (3D). The 3D 
image produced by the O-arm forms a cylindrical tube while the 2D scans are obtained through 
fluoroscopy. Due to the dimensions of the scans (Table 1), it is more convenient to scan small 
skeletal elements, as scanning long bones will require the technician to take two scans and 
merge them together; this is time-consuming.  

During scanning, it is preferred that the bones lie on a surgical bed, beneath a layer of plastic 
or wood. A surgical bed is preferred as its height can be adjusted and it does not have legs 
which could get in the way of the gantry (Fig, 1). The plastic or wood will protect the surgical 
bed’s surface from being damaged by the bone.  Ensure that the bed’s breadth is less than 
70 cm as this is the diameter of the gantry opening. 
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Figure 2: The O-arm with an indication of the gantry an X-ray image on the monitor. 
 

The bones are to be scanned with its respective skeletal number. This is achieved by cutting 
out the numbers from clay and scanning the bones with the number. The clay or modelling 
material should be dense enough to be visible on the scan. 

Tables 2 to 5 specify the details for the different types of 3D scans that can be performed 
using the Medtronic O-arm®. Dose and stereotaxy are terms that should be taken into 
consideration to understand the specifications of certain O-arm scan types. Dose refers to the 
amount of radiation the specimen scanned absorbs and stereotaxy is minimally invasive brain 
surgery, performed using a 3D system allowing precise placement of an electrode, cannula, 
or a probe into a small area of the brain.  

 

Table 1: Three-dimensional image dimensions 

Specification: Detail: 

Cylindrical volume 

20 cm FOV: 
 21.25 cm diameter x 15 cm height 

40 cm FOV: 
 39. 70 cm diameter x 15 cm height 

Resolution (mm) 

20 cm FOV: 
 512 x 512 x 192 

20 cm FOV: 
 512 x 512 x 192 

 

Gantry 

52



Table 2: Three-dimensional High definition scan 

Specification Imaging modality performance 
Data acquisition: < 30 seconds 

 27 seconds 
Number of projections: 745 images are scanned over 360˚ 
Field of view options: The field of view (FOV) may be set at 20cm or 40 cm 

3D reconstruction time: 
< 30 seconds 
 Standard for 20cm FOV: 23 seconds 
 Standard for 40cm FOV: 23 seconds 

Resolution (mm): 20 cm FOV: 0.415 x 0.145 x 0.833 
40 cm FOV: 0.775 x 0.775 x 0.833 

Reconstructed matrix size: 512 x 512 x 192 

Table 3: Three-dimensional Low dose scan 

Specification Imaging modality performance 
Data acquisition: <16 seconds 

 Standard: 14 seconds 
Number of projections: 391 images are scanned over 360˚ 

3D reconstruction time: <90 seconds 
 Standard: 65 seconds 

Field of view options: The field of view (FOV) may be set at 20cm 
Resolution (mm): 0.415 x 0.145 x 0.833 
Reconstructed matrix size: 512 x 512 x 192 

 

Table 4: Enhanced cranial 3D volumetric scan 

Specification Imaging modality performance 
Data acquisition: <30 seconds 

 standard: 27 seconds 
Number of projections: 745 images are scanned over 360˚ 

3D reconstruction time: <30 seconds 
 Standard: 13 seconds 

Field of view (FOV) options: FOV option: 20cm 
 

Resolution (mm): 0.415 x 0.145 x 0.833 
Reconstructed matrix size: 512 x 512 x 192 

 

Table 5: Stereotaxy 3D Volumetric scan 

Specification Imaging modality performance 
Data acquisition: <  30 seconds 

 standard: 27 seconds 
Number of projections: 745 images are scanned over 360˚ 
3D reconstruction time: < 30 seconds 
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 Standard: 13 seconds 
Field of view (FOV) options: FOV option: 40 cm 
Resolution (mm): 0.775 x 0.775 x 0.833 
Reconstructed matrix size: 512 x 512 x 192 

 

(7.0) SURETY: 
Quality is provided in the peer review process VISUN Laboratory Manual, Part III, SOP 3.1 
(Peer Review). If deficiencies in images are noted, the primary analyst will ensure that images 
are retaken appropriately. Forensic imaging is also subject to audits VISUN Laboratory 
Manual, Part III, SOP 3.3 (Audits).  
 

(8.0) AVAILABILITY 
The original signed version of this document is kept by the Curator of the Kirsten Skeletal 
Collection. Training documents available in personnel folders. A copy of the document can be 
found on the document management system ALFRESCO. 

(9.0) DOCUMENT HISTORY 
 

Version 
No. 

Date   Location of Change History Author/ 
Reviewer 

Approving 
Official 

Date 
Approved  

Next Review 
Date 

1.0 20 Nov 
2019 

 A Alblas   2020 
 

2 L Daniels  L Daniels AA Jan 2020  
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SOP 2.2. Scanning and naming conventions 
UP and SMU 

(1.0) Purpose 

The purpose of this document is to detail the scanning procedures to be completed before 
addition to the Bakeng se Afrika digital skeletal repository.   

(2.0) Scope 

This document and the guidelines herein will be used by skeletal collections managers or 
curators, researchers, contractors and/or the individuals responsible for scanning the skeletal 
elements once the material is at the scanning facility (NECSA/ other scanning facility).  

(3.0) Definitions 

For definition of the terminology used in the current document, see SOP 1.1. 

(4.0) Roles and Responsibilities 

The scanning, which includes the naming of scans will be completed by the curator, 
researcher or contractor that brought the skeletal material for scanning. 

(5.0) Procedure 

• Crania

All the folder and files obtained during scanning will be named as follow: 
BsA_institution&cadnr_cranium_scannumber. For instance, for the scan n°1982 of the 
cranium 1750 from the Pretoria Bone Collection of the University of Pretoria: 
BSA_UP1750_cranium_1982. 

All crania will be scanned according to the following parameters: 100µA, 100kV or higher 
if necessary. The number of projections will be determined using the Nyquist theorem. The 
resolution of the crania will be determined by the size of the crania. The highest possible 
resolution is preferred. 

An automatic reconstruction will be made whenever possible and the images from the 
reconstruction will be saved in 16-bit tiffs. After reconstruction, the projections, xtect files 
and reconstructed 16bit tiffs images will be saved for the Bakeng se Afrika server (see SOP 
3 for more details on the procedure). 

A possible mirror might affect the scans. In order to identify the presence of a mirror effect, 
photographs of each skeletal element will be taken prior or after scanning, and compared to 
the reconstructed images (see SOP 4 for more details). If such effect is identified, the data 
should be transformed using any imaging software and save again in 16-bit tiffs. 

• Mandible

All the folder and files obtained during scanning will be named as follow: 
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BsA_institution&cadnr_mandible_scannumber. For instance, for the scan n°1982 of the 
mandible 1750 from the Pretoria Bone Collection of the University of Pretoria: 
BSA_UP1750_mandible_1982. 

All mandibles will be scanned according to the following parameters: 100µA, 100kV or 
higher if necessary. The number of projections will be determined using the Nyquist theorem. 
The resolution will be determined by the size of the bone. The highest possible resolution is 
preferred. 

An automatic reconstruction will be made whenever possible and the images from the 
reconstruction will be saved in 16-bit tiffs. After reconstruction, the projections, xtect files 
and reconstructed 16bit tiffs images will be saved for the Bakeng se Afrika server (see SOP 
3 for more details on the procedure). 

A possible mirror might affect the scans. In order to identify the presence of a mirror effect, 
photographs of each skeletal element will be taken prior or after scanning, and compared to 
the reconstructed images (see SOP 4 for more details). If such effect is identified, the data 
should be transformed using any imaging software and save again in 16-bit tiffs. 

• Focus on dentition 

All the folder and files obtained during scanning will be named as follow: 
BsA_institution&cadnr_maxilla_scannumber. For instance, for the scan n°1982 of the 
maxilla 1750 from the Pretoria Bone Collection of the University of Pretoria: 
BSA_UP1750_maxilla_1982. 

All the crania will be scanned according to the following parameters: 100µA, 100kV or 
higher if necessary. The number of projections will be determined using the Nyquist theorem. 
The resolution will be determined in order to include the maximal number of teeth. The 
highest possible resolution will be preferred while focusing on the dentition. 

An automatic reconstruction will be made whenever possible and the images from the 
reconstruction will be saved in 16-bit tiffs. After reconstruction, the projections, xtect files 
and reconstructed 16bit tiffs images will be saved for the Bakeng se Afrika server (see SOP 
3 for more details on the procedure). 

A possible mirror might affect the scans. In order to identify the presence of a mirror effect, 
photographs of each skeletal element will be taken prior or after scanning, and compared to 
the reconstructed images (see SOP 4 for more details). If such effect is identified, the data 
should be transformed using any imaging software and save again in 16-bit tiffs. 

• Femur 

All the folder and files obtained during scanning will be named as follow, the P indicating 
the femur holding the marker: 

BsA_institution_cadnrP_cadnr_fem_A_scannumber, 
BsA_institution_cadnrP_cadnr_fem_B_scannumber, 
BsA_institution_cadnrP_cadnr_fem_C_scannumber. 

For instance, for the scan n°1982, 1983 and 1984 of the femora 1750 (holding the marker) 
and 1751 from the Pretoria Bone Collection of the University of Pretoria: 
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BSA_UP1750P_1751_fem_A_1982, BSA_UP1750P_1751_fem_B_1983 and 
BSA_UP1750P_1751_fem_C_1984. 

The three scans (i.e., scans A, B and C) will be detailed using the same parameters in order 
to be able to merge then afterwards. In addition, the scans A and B will be made without 
moving the specimen in the machine to facilitate the merging procedure. 

All femora will be scanned according to the following parameters: 100µA, 100kV or higher 
if necessary. The number of projections will be determined using the Nyquist theorem. The 
resolution will be determined in order to include the size of the femora. The highest possible 
resolution will be preferred. 

An automatic reconstruction will be made whenever possible and the images from the 
reconstruction will be saved in 16-bit tiffs. After reconstruction, the projections, xtect files 
and reconstructed 16bit tiffs images will be saved for the Bakeng se Afrika server (see SOP 
3 for more details on the procedure). 

A possible mirror might affect the scans. In order to identify the presence of a mirror effect, 
photographs of each skeletal element will be taken prior or after scanning, and compared to 
the reconstructed images (see SOP 4 for more details). If such effect is identified, the data 
should be transformed using any imaging software and save again in 16-bit tiffs. 

• Radii

All the folder and files obtained during scanning will be named as follow, the P indicating 
the radius holding the marker: BsA_institution_cadnrP_cadnr_rad_A_scannumber and 
BsA_institution_cadnrP_cadnr_rad_B_scannumber. 

For instance, for the scan n°1982 and 1983 of the radii 1750 (holding the marker) and 1751 
from the Pretoria Bone Collection of the University of Pretoria: 

BSA_UP1750P_1751_rad_A_1982 and BSA_UP1750P_1751_rad_B_1983. 

The two scans (i.e., scans A and B) will be detailed using the same parameters in order to be 
able to merge then afterwards. In addition, the scans will be made without moving the 
specimen in the machine to facilitate the merging procedure. 

All radii will be scanned according to the following parameters: 100µA, 100kV or higher if 
necessary. The number of projections will be determined using the Nyquist theorem. The 
resolution will be determined in order to include the size of the radii. The highest possible 
resolution will be preferred. 

An automatic reconstruction will be made whenever possible and the images from the 
reconstruction will be saved in 16-bit tiffs. After reconstruction, the projections, xtect files 
and reconstructed 16bit tiffs images will be saved for the Bakeng se Afrika server (see SOP 
3 for more details on the procedure). 

A possible mirror might affect the scans. In order to identify the presence of a mirror effect, 
photographs of each skeletal element will be taken prior or after scanning, and compared to 
the reconstructed images (see SOP 4 for more details). If such effect is identified, the data 
should be transformed using any imaging software and save again in 16-bit tiffs. 
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SOP 2.2. Scanning and naming conventions 
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(1.0) PURPOSE & SCOPE: 

1) PURPOSE: 

The purpose of this document is to detail the bone preparations and pre-scan procedures to 
be completed when preparing various skeletal elements for scanning for addition to the 
Bakeng se Afrika digital skeletal repository.  
 

2) SCOPE: 
This document and the guidelines herein will be used by skeletal collections managers or 
curators as well as by any researchers scanning skeletal material that will be added to the 
Bakeng se Afrika digital skeletal repository, including but not limited to the curator of the 
Kirsten Collection (housed at the Stellenbosch University), the curator of the Pretoria Bone 
Collection (housed at the University of Pretoria) and the curator of the Human Bone Collection 
(housed at the Sefako Makgatho Health Sciences University) or any researchers or 
contractors and/or the individuals responsible for preparing the skeletal elements for scanning 
once the material is at the scanning facilities. 

(2.0) DEFINITION: 
For the definition of the terminology used in the current document, see BsA.SOP.IMAGE.001: 
Selection of skeletal material for scanning. 

(3.0) ABBREVIATION LIST 
For a list of abbreviations used in the current document, see BsA.SOP.IMAGE.001: Selection 
of skeletal material for scanning. 
 

(4.0) ROLES AND RESPONSIBILITIES 

1) ALL STAFF AND STUDENTS 

• Be aware of the correct operating and maintenance procedures of the imaging 
methodology used. No person will be allowed to operate any equipment without prior 
training and/or certification. 

2) COLLECTIONS MANAGERS/CURATORS/CONTRACTORS: 
• The preparation of the skeletal elements for scanning, which includes replacing teeth 

and reconstructing the cranial vault with the rest of the cranium will be completed by 
the curator, researcher or contractor that brought the skeletal material for scanning.  

3) SCANNING TECHNICIAN/RADIOGRAPHER: 

• Check whether the relevant bones are suitable for scanning 
• Ensure that once they skeletal material is scanned that it is returned to the correct box 

with the corresponding AN number.  
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• Ensure that skeletal material to be scanned will be handled with care by all involved to 
prevent any damages.  

• The stabilisation of the bones within the scanner will be the responsibility of the person 
tasked with operating the scanner at the scanning facility.  

 

(5.0) SCANNING PROCEDURES: 
Always refer to the specific operator’s manual and maintenance procedure of each imaging 
modality for detailed instructions. 
THESE MODALITIES MAY INCLUDE: 

1) X-Rays 
2) Computed tomography (CT-scans) 
3) Microfocus scanning (Micro-XCT),  
4) Magnetic resonance imaging (MRI) 
5) Lodox Statscan 
6) Cone beam (CBCT) 
7) Medtronics O-arm 
8) Cephalograms 

5.1 NUMBERING PROCEDURES 

Number and Authentication: The cadaver or skeletal number should appear in radiographs 
whenever possible. Radiopaque letters and numbers can be used for this purpose in the digital 
radiography of remains using the Faxitron system. If conditions preclude this practice, the 
cadaver or skeletal number should be added later using electronic methods or radiographic 
marker/pen, or it may appear in the caption in the report.  
Records of the use of radiographic equipment are maintained using the Radiography Log. 
These logs include the initials of the person taking the radiographs, the case number of the 
remains radiographed, and the date the radiographs were taken.  
The unique number of each skeletal individual with the specific skeletal element scanned will 
be labelled on each radiograph as part of the stored image. Each radiograph is labelled 
according to the allocated BsA number for the material and the anatomical region being 
scanned.  During post-processing, individual skeletal elements may be exported and labelled 
accordingly. 

BsA_Skeletal number_Region of anatomy_Necsa number 
e.g. BsA_UP_234_femur_Aprox_1234 

BsA_SU_2340_femur_Adist_1235 
BsA_SMU_2340_femur_A_1236 
BsA_FOR_2340_femur_A_1237 
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5.2 IMAGING PROCEDURES 

Quality of Images: Images taken should be of the highest quality possible. It is the 
responsibility of the primary analyst to ensure all photographs are of at minimum acceptable 
quality (e.g., in focus, proper imaging of case, proper colouration). Quality of images should 
also be examined and verified during the peer review process.  
 

1) X-RAYS  
Not used yet 
 

2) COMPUTED TOMOGRAPHY (CT)  
Not used yet 
 

3) MICROFOCUS SCANNING (MICRO-XCT) 
Scanner setup and parameters  
Before each scan is started it is labelled with the AN number and the region of that is being 
scanned, example: AN123 Top left viscerocranium.  
 
Scans are done at 180kV with a beam current of 600uA, with an exposure of 2 frames per 
second (fps) with 2000 projections (i.e. images) taken. These X-ray conditions give the 
optimum trade-off between the time taken to run the scan and the signal-to-noise ratio.  
 
A guideline to use to decide on the resolution to use per scan as follows: 

• cranium  100 μm  
• mandible  60 μm 
• dentition: 40-60 μm 
• inner ear: approx. 20-40 μm  
• humeri: 70-100 μm 
• radius (scanned in 2 arts)  a ro . 50 μm each 
• femur (scanned in 3 parts): approx. 50-70 μm each 
• os coxae: 70-100 μm 
• patellae & calcanei: 20-60 μm 

 
Scanning procedure  
Before starting the scan, the background should be normalized. This is done by moving the 
sample out of the field of view and using the x-ray beam at the chosen settings to correct for 
all variations across the detector. This procedure can be conducted before a scan and it is 
only required once the settings of the scanner are changed or after long periods of inactivity. 
The scanner itself is automated and therefore requires no user interaction during the scanning 
process. 
 
Image reconstruction 
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Once all the 2D projection images are obtained the 3D volume can be reconstructed in VG 
studio. the field of view is cropped to make the total reconstruction volume smaller. This will 
ensure that the reconstruction time is shorter and that less memory is required. This can be 
helpful when time and computational power is limited. The type of output file is chosen, it is 
selected to be an 8-bit. Once the 2DOnce the projections have been reconstructed into a raw 
volume, the volume is imported into VGSTUDIO MAX 3.2.5 for analysis and processing. 
Firstly, since air surrounding the object is included in the reconstructed volume, the surface of 
the object is determined; this discards all the surrounding air and focuses all the analysis on 
the object itself. Thereafter you can focus on the region of the bone you’re interested in, isolate 
it from the rest, and perform the analysis and measurements required, for example, volume, 
surface area, porosity, bone width, etc. 
The projection images are first reconstructed into raw volume data and then imported to 
VGStudio MAX 3.2.5 for processing and analyses. The air surrounding the scanned object is 
included in the reconstructed volume. Thus, the surface of the object must first be determined 
to discard the surrounding air and focus the analyses on the object. Regions of interest on the 
bone may also be selected, isolated from surrounding regions and individually measured and 
analysed. Possible analyses include volume, surface area, porosity and bone thickness. 
 
Thereafter one can focus on the region of the bone interested, isolate it from the rest, and 
perform the analysis and measurements required, for example, volume, surface area, 
porosity, bone width, etc. 
The field of view may be cropped to make the total reconstruction volume smaller. This will 
ensure that the reconstruction time is shorter and that less memory is required, especially 
helpful when time and computational power is limited. The type of output file is chosen, either 
8-bit or 16-bit. The location of the rotation axes is found by an algorithm that it takes the central 
pixels in all 2D images. This improves the quality of the reconstruction and corrects for small 
movements or shift that happened during this scanning process. 
 
Image visualization 
After 3D reconstruction, software tools may be used for the visualisation and analysis of data. 
The specific measurements at specific landmark points as per project proposal will digitally be 
measured using Volume Graphics Voxel® Manipulation software.  
 
 
A guideline to use for average file size (projections + reconstructions)  

• for a mandible: 15 - 35 GB 
• for a femur: 20 - 40 GB (prox. end only) 
• for a skull: 15 - 20 GB 
• for dentition: 5 to 12 GB (8 GB on average - just reconstructions) – 8 bit 

 

4) MAGNETIC RESONANCE IMAGING (MRI) 
Not used for Bakeng se Afrika Project 
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5) MEDTRONIC O-ARM® 
O-Arm® Imaging Specifications for dry bone. 
The technician will adjust the O-arm settings specific to the specimen studied. For 
anthropology, it is suggested that the scan be done in high definition in order to appreciate the 
morphology of the bone. The patient thickness should be selected as “small”, as no tissue is 
present around the bone.  
 
Image optimisation 
The scans can be uploaded to an external memory device and be viewed using a Digital 
Imaging and Communications in Medicine (DICOM) viewer or morphometrics software.   
To study bone morphology, the bone should be scanned dry. Thereafter, the scan can be 
adjusted using the DICOM to optimise image quality. Here the bone can be viewed in 3D and 
the trabecular bone can be studied. Various artefacts can be removed as well by “cutting” it 
out or using volume rendering. Volume rendering is a process which attempts to cancel out 
artefacts and materials that are not bone. 
The quality of the scans is not at the caliber of computer tomography. However, severe trauma 
and reactive pathological lesions can be studied. 
 
Measurements of bone scans 
For osteometry, the bone should be submerged in a medium to simulate soft tissue as most 
imaging modalities are designed to scan bones in-situ. It is proposed that rice be used as it 
does not alter the bone in any way.  
Software specific for osteometry should be used in order to achieve reliable measurements. 
Morphometric software that allows markers to be placed on the specimen is preferred as one 
can easily adjust where the bone should be measured. Additionally, the software should be 
able to render the scans’ volume and convert to various measuring units. 
The measurements are to be recorded on an excel sheet as well as on hardcopy in the event 
the excel document becomes faulty or is deleted. A backup of all documents and scans should 
be kept on a different external memory device. When choosing a scale (mm/cm), ensure small 
skeletal elements are measured in millimetres and larger bones in centimetres.  
 
 

6) LODOX STATSCAN 
Not used for Bakeng se Afrika Project 
 

7) CONE BEAM (CBCT) 
Not used for Bakeng se Afrika Project 
 
 
 

8) CEPHALOGRAMS 
Not used for Bakeng se Afrika Project 
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(6.0) MEASUREMENTS OF IMAGES 
All scans of skeletal elements taken on various modalities will have the unique skeletal number 
visible on the scan. The scans will be uploaded from the external memory to a software 
program where digital measurements will be taken. Each radiological modality used, will have 
specific software for measurement of skeletal elements from the images. All measurements 
taken on images will be recorded on an excel sheet with regular backups on cloud storage as 
well as an external hard drive, both password protected. All measurements are in mm. 
 

(7.0) STORAGE 

7.1 STORAGE OF MATERIAL DURING THE PROJECT (short term) 
The data/images will be stored on REDCap, which will only be accessible to the primary 
researcher, PI, the supervisors of the researcher, and a statistician from the Centre for 
Evidence-Based Health Care, Stellenbosch University.  

7.2 LONG TERM STORAGE OF MATERIAL 
• The scanned digital data will be archived by an electronic central repository (at UP). 
• SUN will have a coordinator to coordinate SU’s link to the SANREN network. 
• The ownership of the projects will remain with the researchers already collaborating. 
• Standard operating procedures and quality assurance guidelines will be created in order 

to manage access and ethical use of the digital database. 
• Online accessibility to this data will be coordinated in Pretoria through a management 

portal. 
• Ethical clearance for using images will be managed by a Data/Image Management 

Committee represented by each of the institutions involved. 
• The applicable data will be uploaded online for dissemination, not only to partner 

Universities but also other national and international research groups following adequate 
ethical approval of research and author permission.  

 

(8.0) DOCUMENTATION:  
 
8.1 Photography: All digital photographs will be maintained on the VISUN laboratory external 
hard drive, as well as a back-up drive. In most instances, the digital images archived in the 
case folder will be considered the official photographic record.  
 
8.1.1 Labeling and Storing Images: Images on the VISUN external hard drive are stored in 
the appropriate case folder, usually labelled “(Case Number) Images” (e.g., “CAS010101 
Images”). These images should typically be high-quality JPEG format and include all arrival, 
pre-maceration, and official case photographs. All images should be saved regardless of 
quality.  
Photographs for each stage of case assessment and analysis should be placed within its own 
folder within the Images folder (e.g., Receipt Images, Maceration Images, Analysis Images). 
JPEG files should be renamed sequentially within each subfolder using the case number and 
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the subfolder name (e.g., “CAS010101 analysis (1),” “CAS010101 analysis (2),” etc.). For 
annotated photos (e.g., photographs for which the analyst wishes to provide additional 
information, the file should maintain the renamed label and the additional information is added 
after (e.g., “CAS010101 analysis (1) anterior cranium”).  
 
8.2 Radiographs: Similar to photographs, all digital radiographs will be maintained on the 
VISUN external hard drive within the case number Images folder, as well as on CDs or DVDs 
in the case file. Radiographs and dental radiographs are to be maintained on an external hard 
drive and the CDs or DVDs in the case file in their original software file format with viewer 
software. This will ensure that each radiographic image (either dental or osseous/materials) 
will maintain an association with the patient information (e.g., station and case number) 
associated with those digital files.  
 

(9.0) SURETY: 
Quality is provided in the peer review process VISUN Laboratory Manual, Part III, SOP 3.1 
(Peer Review). If deficiencies in images are noted, the primary analyst will ensure that images 
are retaken appropriately. Forensic imaging is also subject to audits VISUN Laboratory 
Manual, Part III, SOP 3.3 (Audits).  
 

(10.0) AVAILABILITY 
The original signed version of this document is kept by the Curator of the Kirsten Skeletal 
Collection. Training documents available in personnel folders. A copy of the document can be 
found on the document management system ALFRESCO. 

(11.0) DOCUMENT HISTORY 
 

Version 
No. 

Date   Location of Change History Author/ 
Reviewer 

Approving 
Official 

Date 
Approved  

Next Review 
Date 

1.0 20 Nov 
2019 

 A Alblas   2020 
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SOP 2.3. Reconstructing procedures after scanning 
UP and SMU 

(1.0) Purpose 

The purpose of this document is to detail the reconstruction procedure to follow for addition 
of scans to the Bakeng se Afrika digital skeletal repository.  

(2.0) Scope 

This document and the guidelines herein will be used by skeletal collections managers or 
curators, researchers, contractors and/or the individuals responsible for reconstructing the 
skeletal elements once the material has been scanned correctly at the scanning facility 
(NECSA/ other scanning facility).  

(3.0) Roles and Responsibilities 

The reconstructions of scans will be completed by the researcher or contractor that has been 
trained to do so. 

(4.0) Procedures 

STEP 1 

On the reconstruction computer, copy the folder of the scan(s) from the acquisition PC to the 
desired folder in the D:Drive or to the ‘Recon-busy’ folder on the Necsa server 
(reconstruction computer). 

Open the CT Pro3D program. 

Click Open and select the XTEKCT File (.xtekct) inside the folder of the scan you want to 
reconstruct (this .xtekct file will have the same name as the folder of the scan). 

STEP 2 

Once the CT Pro3D program is opened, you will see five tabs: 

1. IMAGE

Nothing needs to be changed. 

2. CENTRE OF ROTATION

§ There is no need to move the red line, unless a study is specifically focusing on an
area of the sample (bone), such as the orbits. If that is the case, drag the red line on
the image in the left corner down to an area of detail/focus (e.g. anterior of skull,
orbits and nasal area).

§ At Accuracy select high quality and press start (Figure 1a).
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§ Wait for the process to finish. It will show Found when completed (Figure 1b). 

 
Figure 1. Steps to follow in the centre of rotation tab. 

 
§ For the LONG BONE SCANS – if it does not find the bone correctly, select DUAL 

(Figure 1b) and move the red lines in the image to either ends of the bone (Figure 2). 
Press start again and wait for the process to finish. (Dual is generally used if movement 
of the bone occurred during the scanning relative to the rest of the sample, such as with 
a stack of vertebrae). 
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Figure 2. Movement of two red lines (dual) to either end of the long bones or vertebrae stack. 

 
3. SETUP (Figure 3) 

§ Beam Hardening: select number 2. 
§ Noise Reduction: select 2 as well. 
§ Press start, wait for it to finish. 
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Figure 3. Steps to follow in the setup tab. 

 
4. CALIBRATION 

Nothing needs to be changed. 

5. VOLUME 

§ For all scans EXCEPT long bone scans: Crop the images in both 0o and 90o views if 
possible. Be careful not to crop too close to the bone, as this may crop the image of the 
bone itself (Figure 4). 

§ For LONG BONE scans: Do NOT crop. The voxel count under Volume should be the 
same in all three blocks (This is important for stitching; Figure 5). 
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§ Output format: select SINGLE under Tiff 16-bit image stack. 
§ Scaling method should be Full range. See Figure 5. 
§ Press Start.  

 

 
Figure 4. Cropping of the image in 0o and 90o views. The lines indicated by the red arrows 

can be moved as needed. 
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Figure 5. Steps to follow in the volume tab. 

 

STEP 3 

The reconstruction progress can be followed in the CT agent (Figure 6). 

Open CT agent (it is on the right side of the task bar at the bottom of the screen): 

§ Always check under the successful tab if the reconstruction worked or alternatively 
check the failed tab if you aren’t sure the reconstruction worked. 

§ If the reconstruction failed, look what the error was, fix the problem if possible (such 
as lack of space) and try again. 

§ Check the tiff files inside the folder with the reconstructions (usually the folder ending 
in _01) to make sure the reconstruction was successful. 
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Figure 6. Follow the reconstruction progress in the CT agent. 

 

STEP 4 

Copy the entire folder onto an external hard drive or to the Bakeng se Afrika server at Necsa. 

Once copied, check that the sizes of the folders are the same under properties. 

Shift-Delete the folder on the Necsa reconstruction computer and acquisition PC (to clear out 
space). 

Obtaining data for the Scanning database spreadsheet: 

§ date_scanned: Indicated on the name of the file inside the [ ], for e.g. 
BSA_UP_Skull_5769_1274 [2020-10-06 12.16.29]. 

§ original_scan_name: The name of the folder containing the scans. 
§ Xray (kV) and Xray (uA): Inside the .xtekct file, scroll to the bottom to find these 

values. 
§ projections/360: Open the .txt file name _ctdata (inside the folder). In the top left 

corner of the document you will find the value under the heading ‘projections’. 
§ scanning_resolution: Inside the .xtekct file, it is the value of the VoxelSizeX (and Y 

and Z). 
§ recon_resolution: Open the .xtekct file inside the folder containing the reconstructed 

scans. It is the value of the VoxelSizeX (and Y and Z). 
  

74



STEP 1 

On the reconstruction computer, copy the folder of the scan(s) from the acquisition PC to the 
desired folder in the D:Drive (reconstruction computer) 

Open the CT Pro3D program. 

Click Open and select the XTEKCT File (.xtekct) inside the folder of the scan you want to 
reconstruct (there should be 2 files - one is inside the folder one is not - select the one that is 
not in the folder) 

STEP 2 

Once it is opened, you will see five tabs: 
1. IMAGE

Nothing needs to be changed

2. CENTRE OF ROTATION

§ For the CRANIA: There is no need to move the red line on the image, unless a study is
specifically focusing on an area of the sample (bone), such as the orbits. If that is the
case, drag the red line on the image in the left corner down to an area of detail/focus
(e.g. anterior of skull, orbits and nasal area).

§ For the VERTEBRAE STACKS: select DUAL and move the red lines in the image to
either ends of the stack. Make sure that the centre of rotation at slices for both upper and
lower are close in value and the scan should then be found (Figure 2). (Dual is used
because movement of the bone relative to the rest of the sample can occur during the
scanning).

§ At Accuracy select high quality. Press Start.
§ Wait for the process to finish. It will show Found at the bottom of the screen when

completed (Figure 1).

3. SETUP

§ For vertebrae stacks: move the red line to the middle of the stack (ignore this step for
scans of other types of bones).

§ Beam Hardening: select 2.
§ Noise Reduction: select 2.
§ Image processing: select “Enhance- Mild” (Figure 7).
§ Press start, wait for it to finish.

SOP 2.3. Reconstructing procedures after scanning 
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Figure 7. Steps to follow in the setup tab.

4. CALIBRATION

Nothing needs to be changed.

5. VOLUME

§ Crop the images in both 0o and 90o views if possible (Figure 4). Be careful not to crop
too close to the bone, as this may crop the image of the bone itself.

§ Output format: select SINGLE under Tiff 16-bit image stack (Figure 5).
§ Scaling method should be Full range.

STEP 3 

The reconstruction progress can be followed in the CT agent (Figure 6). 

Open CT agent (it is on the right side of the task bar at the bottom of the screen) 

§ Always check under the successful tab if the reconstruction worked or alternatively
check the failed tab if you aren’t sure the reconstruction worked.

§ If the reconstruction failed, look what the error was, fix the problem if possible (such
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as lack of space) and try again. 
§ Check the tiff files inside the folder with the reconstructions (usually the folder ending 

in _01) to make sure the reconstruction was successful. 

STEP 4 

Copy the entire folder onto an external hard drive or the Bakeng se Afrika server at Necsa. 

Once copied, check that the size of the folders are the same under properties. 

Shift-Delete the folder on the Necsa reconstruction computer and acquisition PC (to clear out 
space). 
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SOP 3. POST-SCANNING PROCEDURES 
 

SOP 3.1. 2D stitching long bones scanned in two- or three-parts using 
ImageJ 

 

(1.0) Purpose 

The purpose of this document is to detail the stitching procedures to follow the reconstruction 
for addition of scans to the Bakeng se Afrika digital skeletal repository. Because the long 
bones are too large to scan in one part at an adequate resolution, the bones will be scanned in 
two (proximal and distal halves) or three parts (proximal half, diaphysis, distal half). Each 
scan limit will be demarcated on the bone using Prestik or clay. For example, for the radii, 
the midpoint is marked with Prestik. 

(2.0) Scope 

This document and the guidelines herein will be used by skeletal collections managers or 
curators, researchers, contractors and/or the individuals responsible for stitching the skeletal 
elements once the material has been scanned correctly at the scanning facility (NECSA/ other 
scanning facility). 

(3.0) Roles and Responsibilities 

The stitching of long bones scans will be completed by the researcher or contractor that has 
been trained to do so. 

(4.0) Procedures 
 

STEP 1 – Reconstruction 

When long bones are reconstructed, the normal reconstruction procedure takes place, except 

that no cropping should be done. See Figure 1. 

• Selection: no cropping in the 0° or 90° views. 

• Volume 

o Count: should be 2048 x 2048 x 2048 voxels. 

• Output format: Select TIFF 16-bit image stack and Single. 
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Figure 8. Reconstruction procedure of radii. 
 
STEP 2 – Folders 
Once the reconstructions of all parts of the bone have been completed, use the analysis 

computers. 

• Open one of the two (or three) scan folders obtained for each long bone. For consistency, 

always choose the proximal half folder. 

• Create a folder called “Merged” (Figure 2). Open it. 

 
Figure 9. “Merged’ folder created. 

 
• In “Merged”, create two new folders called “Proximal” and “Distal” (Figure 3). 
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Figure 10. “Distal” and “Proximal” folders created in “Merged”. 

 

STEP 3 – Importation in ImageJ 
Using the raw images in their folders, try to identify where the Prestik is placed and where is 

the zone of transition. Then,  

• Open ImageJ 

• File → Import → Image Sequence (Figure 4). 

o A dialog box open. Open the reconstruction folder of the proximal half of the long 

bone and select the first image. Open. 

o Sequence Options dialog box will open → OK (Figure 4). The importation of the 

stack is starting (it can take a while). 

 
Figure 11. ImageJ importation. 

 

STEP 4 – Locate the Prestik 
In the new ImageJ window opened, you can scroll through the scan manually or use the bottom 

bar (play and arrows). Arrows should allow you to move slice per slice. 

• Identify the Prestik: the top or the bottom of it (both of them can be used for the process 

– but try to be consistent and always use the same one), i.e., stop on the slice where the 

Prestik can no longer be seen. 
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• Note the slice number – see the top left corner of the window (Figure 5 – in this 

example: slice 1957 but location of the Prestik is scan-specific, it will never be at 

the same slice number). 

 
Figure 5. Slice number at top left corner. 

 
STEP 5 – Renaming in XnView 
If in Step 3, you loaded the proximal half of the long bone, every slice below and including that 

number will have to be copied and pasted into the “Proximal” folder created. However, if the 

distal part is loaded, every slice above and including that number will be copied and pasted into 

the “Distal” folder created (in our example, slices 0 to 1957 included). 

 

The files in the reconstruction that are placed on top during the stitching process will then need 

to be renamed to match the file names used in the reconstruction placed at the bottom during 

the stitching process. 

• Open XnView and locate the folder containing the files to be renamed. 

• Select all the files. 

• In the top bar, Edit → Rename (Figure 6). 
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Figure 6. Rename in XnView. 

 

• A dialog box opens (Figure 7). 

o Select “Name Template”. 

§ Copy the file name (without the end number) from the files you wish to 

rename your files to 

§ Paste the name ensuring that the “####” in the name is kept. 

o Start: type in the number from which the scans will start. The number indicated is 

the number after the last number in the other folder so that all the files follow on 

from each other. 

o Double check the files name to make sure they match. 

o Click Rename and wait. 
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Figure 7. Rename dialog box. 

 

Once renaming is finished 

• Open the Folder containing the newly renamed files  

• Copy and paste them into the second folder so that all the files are in the same folder. 

This is the final merged Tiff Stack. 

The names of the files need to be double checked again so that they are all the same and have 

the correct numbering or the file will not open later. 

 

STEP 6 – Cropping in ImageJ (can also be done in VGStudio, or in Avizo) 
The new merged scan created is very big, we will have to crop what is unnecessary. 

• Open ImageJ 

• File → Import → Image Sequence 

o Select the first file of your newly merged stack. Wait for the importation to finish – 

it can take time. 

•  Scroll through of all the slices to check if the Prestik Marker can be seen and that the 

files merged correctly. 

• Select the crop tool and draw the rectangle on the scan (Figures 8 and 9). Scroll through 

all slices and make sure the bones are in it. 
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Figure 8. Crop tool 

 
Figure 9. Cropping process 

 

• Image → Crop (Figure 10). 

 
Figure 10. Cropping process. 

Save the cropped stack 

• File → Save as → Image Sequence (Figure 11). Find the empty folder and save there. 
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Figure 11. Saving process. 

 

• Rename the folder. 

 

STEP 7 – Final check in VGStudio or Avizo 
Check the stitching process was done correctly by opening the image stack in VG Studio or 

Avizo. 
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SOP 3.2. 3D stitching long bones scanned in two- or three-parts using 
VGStudioMax 

 

(1.0) Purpose 

The purpose of this document is to detail the stitching procedures to follow the reconstruction 
for addition of scans to the Bakeng se Afrika digital skeletal repository. Because the long 
bones are too large to scan in one part at an adequate resolution, the bones will be scanned in 
two (proximal and distal halves) or three parts (proximal half, diaphysis, distal half). Each 
scan limit will be demarcated on the bone using Prestik or clay. For example, for the radii, 
the midpoint is marked with Prestik. 

(2.0) Scope 

This document and the guidelines herein will be used by skeletal collections managers or 
curators, researchers, contractors and/or the individuals responsible for stitching the skeletal 
elements once the material has been scanned correctly at the scanning facility (NECSA/ other 
scanning facility). 

(3.0) Roles and Responsibilities 

The stitching of long bones scans will be completed by the researcher or contractor that has 
been trained to do so. 

(4.0) Procedures 
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1. General steps and notes for VGStudio: 

1.1. Importing data into VGStudio  

1.1.1. Open VGStudio software 

1.1.2. Click on File > Import > Image stack > Directory > {locate and click on the data 
you want to import. (Figure 1). OR 

 
Figure 1. Importing data into VGStudio 

1.1.3. Click on File > Import > VGL (volume from .vgl file) > Browse >  {locate and 
click on the data you want to import > Next (Figure 2)   
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Figure 2. Importing vgl files into VGStudios 

1.1.4. Make sure that sort: Canonic Up and file type: TIFF Images. Click Next. 

1.1.5. Insert resolution into boxes x, y and z (locate these values in the .xtek file inside 
the reconstruction folder) (Figure 3) 

1.1.6. Check that the file type: Tiff, Map to: 16 bit (note: if you want to change the file 
to 8 bit, you can do it here by changing the Map to: 8 bit) (Figure 3) 

88



 

Figure 3. Inserting the X,Y, and Z values.  

 

1.1.7. Click on Histogram. (This is to check the grey value distribution of the data that 
you are importing. For 16 bit files, the histogram will be a solid continuous 
spectrum. For 8 bit files, there will be vertical gaps in the histogram). (Figure 4) 

 
Figure 4. Histogram 
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1.2. Calibration 

(This is to ensure the files have matching grey values)   

1.2.1. Select Calibration (Figure 4). Select a slice with very dense bone (Figure 5). 

1.2.2. Click Define Background. Zoom in on a bone. Select a small rectangle of 
background as close to the bone as possible to calibrate the background grey value. 
Avoid any polystyrene pieces if present. The green rectangle will disappear when it 
is finished calibrating (Figure 5). 

1.2.3. Click Define Material. Select a very small section of the bone (avoid porosities). 
The red rectangle will disappear when the calibration is complete (Figure 5). 

1.2.4. Click Apply. The background should darken. Back on the “Load as” screen, the 
Lowest grey value should now be 0 in the right side of the panel (Figure 5). 

 
Figure 5. Define the material and the background to ensure matching grey-values for the 
multiple scans per bone. 
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Figure 6. Grey value zeroed after defining the material and background. 

1.2.5. Hide the Preview. 

1.3. Removing edge artefacts 

This removes any projection artefacts which may result in loss of data in the final merged bone. 

1.3.1. Click Preview (Figure 4) 

1.3.2. On the top projection, the bone should be visible within a circle. Crop the bones 
out to remove as much of the circular edges as possible (these might be visible 
later). Ensure all the scanned material (including the Prestik) is in the selection. 
(Figure 7) 

1.3.3. In the Front Projection, drag the top and bottom of the blue rectangle to crop out 
any edge artefacts. These might be clearly visible as lighter sections in the 
background. (Figure 7) 
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Figure 7. The blue square is used to crop out the ring edge artefacts in the Top projection. 

1.3.4. Select Hide. 

1.4. Click on Finish. 

1.4.1. When uploading another dataset, always select ‘remove all’ before selecting 
Directory. (File > Import > Image Stack > Remove all > Directory) 

 

1.5. Checking the locks 

1.5.1. Always check that the locks on each volume or dataset (in the scene tree tab) are 
closed, unless a process requires it to be unlocked. 

1.6. Changing the speed at which to turn the bone in 3D view 

1.6.1. In the 3D view (right bottom block) the Preview can be changed to 1. This will 
move the bone at a slower rate and will not pixelate the image as you turn the bone. 

 
2. Import the first two scans for merging 

Note: This is for the two scans where the bone was not moved between the first two scans. 
For femur scans, this was generally the middle and distal parts of the femur. The bone would 
have been rotated upside down in order to scan the proximal or third part. For shorter bones, 
such as the radius, this would include both scanned parts. In this SOP, the following was 
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used as an example: A = distal, B = middle, and C = proximal part of the bone (e.g. for the 
distal scan of the femur of cadaver numbers 5889 and 6453, the name of the file will be 
BsA_UP_fem_5889P_6453_A. The P indicates on which bone an extra Prestik marker is 
placed, to match the correct bones with each other) 

2.1. Import the datasets for the first two scans (A and B) into VGStudio – refer to section 1 
above. 

2.2. Choose part B (scan of the middle of the bone), as a reference for the below processes. 
DO NOT MOVE THIS PART during the entire process, i.e. the lock will always stay 
locked. 

3. Change the background colour and reduce the noise  

3.1. Select A in the scene tree tab (Figure 8) 

 

Figure 8. Scene tree tab where you select which volume you want to work with. 

3.2. Right click on the background in any of the four boxes/grids > background > black 
(Figure 9) 
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Figure 9. Changing the background colour to black and in the rendering tab noise reduction can 
be accomplice by moving the red and blue lines. 

3.3. In Rendering tab, move the red line to the right until the bone is clearly visible. The 
blue line can also be moved slightly to the right (at the horizontal axis) – be careful not 
to move it too much as this will remove information (such as the trabecular bone). 
(Figure 9) 

4. Find the absolute distance that the scan moved down 

4.1. Change the built-in coordinate systems from ‘volume gride’ to ‘scene’ (this will change 
the metric unit at the bottom of the 2D views to mm). (Figure 8) 

4.2. For the following steps, decide whether to use the top or the bottom of the Prestik 
marker on the bone. For the purpose of the SOP the top of the Prestik will be used. This 
should be the same in parts A and B. (Note: you can also use any landmark on the bone, 
as long as you can find the same landmark on both scans A and B). 

4.3. In the scene tree tab, Select part A. 

4.3.1. Go to the top left block (top view of the bone) and place the cursor over the  [  
] sign. Drag the mouse up or down to go through the slices until you are close to the 
top of the Prestik, then use the wheel of the mouse until you find the slice where the 
Prestik is absent (i.e. the slice just above the Prestik). You can also choose to use the 
bottom of the Prestik (i.e. the slice just before the Prestik disappears). (Figure 10) 
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Figure 10. Finding the slice just above or below the Prestik 

4.3.2. Record the mm value at the bottom of the top left block (Figure 10). 

4.4. Repeat the process for part B.  

4.5. Add the two values together, and record this value. One value will be positive, and the 
other negative – disregard the negative (Figure 11). 

 

Figure 11, Calculation of the position of the two Prestiks. Finding the zone of overlap. 
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4.6. In the scene tree tab, select A and unlock the lock (Figure 12). 

 

Figure 12. Unlock Volume A 

4.6.1. In the transformation tab > Position > insert the total value (step 4.5) into the z 
axis with a (-) in front. The (-) will move part A down – remember that B, the 
reference, should not move (Figure 13). 

 
Figure 13. Move part A down, so that the zone of overlap can be aligned. 

4.7. Lock the lock on Part A. 
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Note: The two parts of the bone should now be merged in the vertical axis. If the scan 
was not cropped under the Volume tab during the reconstruction process, this step is now 
complete. If all or one of the scans were cropped, either in reconstruction or when 
opening the scan (Section 1.3 above) the two parts of the bone will not be aligned in the 
horizontal axis. If so, follow the next step.  

5. Move part A horizontally to merge with B 

5.1. Use the [  ] to rotate the view in 3D in order to view the bone from the side. 

5.2. Unlock and select A (Figure 12): manually move part A horizontally as close as 
possible to part B (if you move it up or down, you have to redo step 4.6 and 4.7 

above):. Use the [  ] to move the bone left and right. 

5.3. Lock A. 

5.4. Select A. Go to Object > Surface determination 

5.4.1. Select Approach: Advanced (classic), Material definition: automatic, press Finish 
(Figure 14).  

 
Figure 14. Surface determination of a volume. 

5.5. Repeat for B. 

5.6. Go to Object > Register object > Best fit registration 
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5.6.1. The object to be registered should be A, object to be fitted to should be B. Move 
the cursor to a value of between 40 and 50 (Figure 15) 

5.6.2. Tick the boxes: consider current transformation and consider surface orientation 
(Figure 15) 

 
Figure 15. Register object – to fit part A to part B automatically. 

5.6.3. Click Finish. 

5.7. Parts A and B should now be merged and aligned. Check that the process was 
successful (Figure 16). If not, repeat the manual movement and Best fit registration 
steps. 
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Figure16. Part A and B stitched together for each bone. 

5.8. Right click on A and remove surface registration, then do the same for B 

6. Separate or isolate the two bones scanned together 

6.1. Select A.  

6.1.1. Click the green rectangle (left side of the screen) [   ] > Drag a box around 
the bone to be isolated. Move the red lines or red crosses in all the 2D views. Move 
through all the slices in the top view, to ensure that the entire bone is inside the ROI 
box (Figure 17). 
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Figure 17. Separating the 2 bones from each other by creating a region of interest around each 
individual bone. 

6.1.2. Press create ROI (Figure 18). 

 
Figure 18. Create an ROI by clicking on the red square. 

6.1.3. Click on the created ROI in the scene tree tab. Draw additional boxes on areas 
where the second bone is inside the above ROI. Press Subtract ROI. (if needed) 
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6.1.4. Select ROI, right click > extract ROI.  

6.1.5. Rename extracted ROI to the cadaver nr (for example) and A. Include a P if a 
Prestik marker is on the bone - eg. 5994P A  

6.2. Repeat for B 

6.3. For each part (A and B), right click on the ROI > invert ROI 

6.4. Right click on ROI created > extract ROI.  

6.5. Rename extracted files as mentioned above. 

Note: For bones with only two scans (such as a radius), the process is now complete. Proceed to 
section 10 to save the data.  
 
7. Merge Part C to Part B 

7.1. Import the tiff files of part C into VGStudio.  

7.2. In the scene tree tab, select Part C. 

7.2.1. Go to the rendering tab. Move the red line to the right until the bone is clearly 
visible (if needed) 

7.3. Unlock and select C. Go to the Transform tab > Rotation. Rotate the bones to be in the 
same orientation as Part B. Lock C. (Note: this step is not always necessary, as the 
program can automatically do this with the Best fit Regression) 

7.3.1. Go to Object > Register object > Simple registration 

7.4. Click on the top view (top left corner), and rotate the bones so that the two bones are 
parallel to each other (this will make the isolation of the bones easier). 

7.5. Proceed to isolate the two bones of part C by creating a ROI and extracting the ROI, 
and rename (refer to steps 6.1 above) 

7.6. Select B’s extracted ROI (only if the surface determination has been removed) 

7.6.1. Click on Object > Surface determination 

7.6.2. Select Approach: Advanced (classic), starting contour: from histogram; material 
definition: automatic, press Finish.  

7.7. Repeat for part C’s extracted ROI. 

7.8. Click on Object > Register object > Best fit registration 
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7.8.1. Object to be registered: C, Object to be fitted against: B. Quality level: anything 
above 20 is fine. 

7.8.2. Select the box: consider surface orientation 

7.8.3. Press Finish. 

Note: If the merging was unsuccessful, move part C manually to match part B as close as 
possible (Use the [  ] to move the bone left and right), and repeat the best fit registration. 

7.9. Check that the parts of the bones merged correctly: View the region of overlap in the 
3D view. In the Rendering tab, move the red line to the right (or left). The point of 
overlap should fade away. The region of overlap can also be checked in the 2D views. 
Move the blue line on the horizontal axis to reduce the noise in the 2D views. 

7.9.1. The parts should be completely aligned and transition smoothly.  

7.10. Repeat for the second bone. 

8. Group parts A, B and C of the same bone 

8.1. Select the extracted ROI’s of A, B and C for the same bone (same individual). 

8.2. Right click > Group Objects. 

8.3. Rename Group to the cadaver number (remember to add the P for Prestik if applicable). 

9. Removing rings around the bones (if not done in the beginning) 

If the scanning tube is visible on the merged scan of the non-prestik bone (Inverted ROI), it 
can be removed by further extracted the bone. Most of this should have been cropped out in 
Section 1.3, but a few sections might still be visible. If no external artefacts are visible, 
continue to Section 10. 

9.1 Select Part A of the inverted bone. 

9.1 Select the green pencil (draw function) on the left side [ ]. 

9.3 Change radius to 40mm (for radii) and thickness to the maximum value possible.  

9.4 Select 2D disc mode. 

9.5 Move the yellow circle to encircle the entire bone in the tube while excluding the visible 
rings from scanning support structures. 

9.6 Click anywhere to save the ROI. If the circle does not move it is busy creating the ROI. 
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9.7 Extract the new ROI. Rename it to the bone name (should be the bone without the P) 

9.8 Repeat for Part B. 

9.9 Group the new extracted ROIs and rename to the cadaver number. The first grouping can 
now be deleted. 

10. Saving of stitched bone 

10.1. For A and B (or A, B and C): Click Object > Remove surface determination 

10.2. Center each part by clicking the [   ] icon at the right hand side of the top view (top 
left box) 

10.3. Make sure all 2 (or 3) parts are selected (in the scene tree tab) (Figure 19) 

10.4. Select File > export > Export aligned/multiple volumes (this also ensures that grey 
values of the bone are similar and in the same range) (Figure 19) 

 
Figure 19. Exporting the stitched and separated bone to save as a new folder. 

 

10.5. Check settings and selections (A, B and C should be visible under Source Volumes) 
(Figure 20) 
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Figure 10. Ensure all the parts for each individual bone is selected. 

10.6. Save images in a new folder (e.g. BsA_UP_fem_4996P_merged) as Tiff images. Use 
the same naming convention as the original scan (refer to SOPXXXX) with only the 
cadaver number of the one bone in the merged file. Save the merged scan as the 
cadaver number with an underscore at the end (BsA_UP_fem_4996P_) at the end. 
Remember to include the P after the cadaver number if this bone contained the extra 
Prestik marker (Figure 21). 
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Figure 21. Name for saving the stitched and separated bone. 

10.7. Click save. 

10.8. When asked if you want to create a .vgl project, say yes. Name the file 
BsA_institute_bone_cadavernumber_merged (Figure 22) 
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Figure 11. Saving a vgl file for each bone. 

10.9. Repeat for the second bone. 

11. Cleaning of noise after stitching (optional) 

11.1. Reload merged file into VGStudio. 

11.2. Select the merged file in the scene tree tab. 

11.3. In the Rendering tab, move the red line to the right, past the two or three noise spikes 
(one for each scanned part of bone). This is for the 3D view. The point of overlap 
should fade away. 
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11.4. Click the blue line in the Rendering tab and move the bottom of the line to the right. Do 
not move the line too much, as you will lose information. Take note of the trabecular 
bone as you move the line. The blue line is for the 2D view. 

11.5. Select File > save as > image stack. 
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SOP 4. METADATA – PHOTOGRAPHY 

(1.0) Purpose 

The purpose of this document is to detail the photography of human skeletal remains to 
supplement scanned material in the Bakeng se Afrika digital skeletal repository. 

(2.0) Scope 

This document and the guidelines herein will be used by skeletal collections managers or 
curators, researchers, contractors and/or the individuals responsible for photographing the 
skeletal elements that have been scanned. 

(3.0) Roles and Responsibilities 

The photography of bones will be completed by the researcher or contractor that has been 
trained to do so. 

(4.0) Equipment required 

Camera: All photographs for a single institution must be taken with cameras of the same 
specifications. Camera settings: 

• ISO – Lowest native setting on the camera
• F-stop – 5.6
• Shutter speed – Auto
• White balance – Iridescent (lightbulb icon)

Cloth as background: To ensure an easily editable photograph, all bones should be 
photographed on the same solid, single-coloured background. 

Memory cards and storage: After photography, all photographs will be backed up and 
stored on an external hard drive. 

Photography stand: To ensure photographs are taken from the same distance and parallel 
to all bones, a photography stand with light-fixtures should be set-up and remain unmoved 
for the duration of photographing a single type of bone. If the stand must be moved between 
photography sessions, the exact height must be recorded to ensure future photographs are 
taken with the same field of view. 
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Figure 1: Photography stand setup used at UP 

Skull cushion: Used to stabilise skeletal elements during the photography process. 
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• Lay the cloth down on the photography stand
• Switch on all lights and direct them at the centre of the table

• Secure the camera to the photography stand and adjust the parallel arm to 270mm

above table height

o Measurements are taken along the silver perpendicular arm

Step 2: Specimen numbers 

• Take a photo of the cadaver/specimen number to indicate the start of the specimen photo-

series

Step 3: Photograph the specimen  

• Use a skull-pillow to prop the crania
• Photograph the crania in the following order with the camera lens on the max zoomed

out:

o (1) Anterior, (2) Left, (3) Posterior, (4) Right,

o (5) Superior and (6) Inferior (with anterior facing towards the photographer –

i.e. down)

o Multiple photographs of a single view can be taken as long as order is not

disrupted

o Do not delete any images during the photography process

Step 4: Specimen numbers 

• Take a photo of the cadaver/specimen number to indicate the end of the specimen photo-

series

SOP 4.1. Photographing crania
UP, SUN and SMU 

The same photos are used for crania and maxilla scans. Crania will use the full six 

views (anterior, left and right lateral, posterior, superior and inferior), whereas maxilla will 

only use the anterior and inferior views of the crania.  

Step 1: Set-up 
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Step 5: Documentation 

• Take note of the photograph number on the first and last photograph taken and fill it into

the spreadsheet

In case of specific pathologies or trauma 

• Photographs of specific features must be taken after the standard 6-views
• Photograph the trauma or pathology up-close
• Only zoom with the camera lens – never the arms on the photography stands

• Hands might be visible when holding the bone to display certain features o These can 

be removed during post-processing 

o Limit visibility of hands and/or props as much as possible

• If trauma or pathology is present and photographed, repeat steps 4 and 5

MANDIBLE 
Step 1: Set-up 

• Lay the cloth down on the photography stand
• Switch on all lights and direct them at the centre of the table
• Secure the camera to the photography stand and adjust the parallel arm to 270mm above

table height o Measurements are taken along the silver perpendicular arm

Step 2: Specimen numbers 

• Take a photo of the cadaver/specimen number to indicate the start of the specimen photo-

series

Step 3: Photograph the specimen  

• Use a skull-cushion to prop the mandible if necessary and zoom in all the way

• Photograph the mandible in the following order with the camera lens on the max 

zoomed in (only zoom with the camera, never the photo stand arm):

o (1) Occlusal (2) Anterior 

o Multiple photographs of a single view can be taken as long as order is not 

disrupted
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o Do not delete any images during the photography process

Step 4: Specimen numbers 

• Take a photo of the cadaver/specimen number to indicate the end of the specimen photo-

series

Step 5: Documentation 

• Take note of the photograph number on the first and last photograph taken and fill it into

the spreadsheet

112



Step 1: Set-up 

• Lay the cloth down on the photography stand
• Switch on all lights and direct them at the centre of the table

• Secure the camera to the photography stand and adjust the parallel arm to 270mm above

table height

o Measurements are taken along the silver perpendicular arm

Step 2: Specimen numbers 

• Take a photo of the cadaver/specimen number to indicate the start of the specimen photo-

series

Step 3: Photograph the specimen  

• Place the long bone on the table with proximal facing left o Skull-cushion may be used

to stabilise the bone on the proximal and distal ends

• Photograph the femur in the following order with the camera lens on the max zoomed

out:

o (1) Anterior, (2) Lateral, (3) Posterior, (4) Medial

o Multiple photographs of a single view can be taken as long as order is not

disrupted

o Do not delete any images during the photography process

Step 4: Specimen numbers 

• Take a photo of the cadaver/specimen number to indicate the end of the specimen photo-

series

Step 5: Documentation 

• Take note of the photograph number on the first and last photograph taken and fill it into

the spreadsheet

SOP 4.2. Photographing postcrania 
UP    
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In case of specific pathologies or trauma 

• Photographs of specific features must be taken after the standard 4-views
• Photograph the trauma or pathology up-close
• Only zoom with the camera lens – never the arms on the photography stands

• Hands might be visible when holding the bone to display certain features o These can 

be removed during post-processing 

o Limit visibility of hands and/or props as much as possible

• If trauma or pathology is present and photographed, repeat steps 4 and 5
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Step 1: Transfer photographs 

• At the end of each session, transfer all photographs taken onto the designated hard

drive under the folder “ORIGINAL”

Step 2: Selecting photographs 

• Photographs of specimen will be clearly delineated by close-ups of the cadaver number

• Select the best photograph of each view of the specimen

• Copy the selected photographs into the folder “CURATED” under a folder for the

specific bone

• Put the selected photograph numbers into the spreadsheet for each view
• Once copied into the curated folder, all photos of that bone can be deleted from the

original folder

Table 1: General Photoshop shortcut keys 
Ctrl + c  Copy selection  
Ctrl + v  Paste selection  
Ctrl + x  Cut selection  

Ctrl + z (1st time)  Undo  

Ctrl + z (2nd time)  Undoes the undo  

Ctrl + alt + z  Undo more than one step  
Ctrl + e  Merge selected layers   
Ctrl + t  Transform   
Ctrl + n  New canvas  
Ctrl + +  Zoom in  
Ctrl + -  Zoom out  
Ctrl + s  Save as photoshop image (.png)  
Ctrl + d  Deselect – makes “running ants” go away  
[ or ]  Smaller or larger brush cursor  

Remove the background 

1. Open image with Photoshop CS5

2. Select the (W) – make sure it is not the magic wand

SOP 4.3. Post-photography processing 

Step : P n  n  P
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3. At the top of the toolbar make sure to select the  tool  

4. Run cursor over skull until entire skull is surrounded by “running ants”. (you can select

and release – you don’t need to do everything in a single stroke)

5. Use zoom in (ctrl +) to make sure that everything is selected (use ctrl + z or ctrl + alt +

z to undo extra bits or use the  tool at the top toolbar).

6. When whole skull is selected press ctrl + c to copy the selected bit.

7. Ctrl + n to open a ‘New’ window.

8. Create a canvas of 2500 pixels x 2500 pixels for crania and mandibles. Make sure the

pixels by inch is 300 (resolution of the image) and the colour is RGB and 8-bit. Press

enter.

9. Ctrl + v to paste the image onto the new canvas as a new layer.

10. Use v to move the layer to your preferred location on the canvas. Centre the image.

11. Use ctrl + t to rotate the image (always press enter after ctrl + t to be able to do anything

else).

For the skull: Left and right views must be in Frankfort Horizontal. For superior and
inferior views, rotate so that anterior is up. Do not resize or transform the image.

For the ribs: The first rib should be up for both superior and inferior views.
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    For the mandible: Resize the image to 70% in the top bar - ensure the chain lock is 

selected to resize to 70% in both width and height .  
For occlusal view, rotate so that anterior is down. Do not resize or transform the image. 

    For the vertebrae: Create a canvas of 3500 pixels x 3500 pixels for the vertebrae. Make 
sure the pixels by inch is 300 (resolution of the image) and the colour is RGB and 8-bit. Press 
enter. Resize the image to 75% in the top bar for posterior and lateral views and 65% for 
anterior- ensure the chain lock is selected to resize to 75% (posterior and lateral) and 65% 
(anterior) in both width and height. Centre the image. Do not resize the logo. 

12. Click on the background layer in the layers tab.

13. Use the  tool or  tool and pick a black to fill in the background.  

Add the Bakeng se Afrika logo  

1. Drag and drop the file of the Bakeng se Afrika logo onto the image in Photoshop.

2. Select the chain to lock the logo size and change the W to 30%

3. Drag the logo to the top right corner of the canvas for crania and bottom right corner

for mandibles.

4. Press enter.
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Table 1: General GIMP shortcut keys

Ctrl + c Copy selection 
Ctrl + v Paste selection 
Ctrl + x  Cut selection 
Ctrl + z (1st time) Undo 
Ctrl + y Undoes the undo 
Ctrl + i Invert selection 
Ctrl + b Bucket fill 
Ctrl + 2 Foreground select 
Ctrl + n New canvas 
Ctrl + s Scale image 
Z Zoom 
M Move 
Shift + Ctrl + s Save as gimp image (.xcf) 
Shift + Ctrl + e Export image as jpg or png 

Remove the background 

1. Open GIMP 2.10.22

2. Ctrl + n to open a ‘New’ window.

3. Create a new canvas

a. For crania and mandibles: 2500 pixels x 2500 pixels

b. For long bones: 5000 pixels x 2000 pixels

c. Make sure the pixels by inch is 300 (resolution of the image) and the colour is
RGB and 8-bit. Press enter.

4. File > Open as Layer… and choose image of skull

5. Resize layer to have bone fit canvas:

a. Layer > Scale Layer > select % and rescale width and height at the following

proportions and make sure to keep proportions constrained

i. Crania at 70%

ii. Mandibles at 120%

iii. Femur at 80%

iv. Humerus, Radius and Ulna at 120%

Step : P n  n  
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6. Select the Foreground Select tool

7. Roughly draw around bone and press enter

8. Adjust the settings to Draw foreground, adjust to desired stroke width and draw around

the borders of the bone on the foreground

9. Alternate between Draw foreground and Draw background to make sure entire bone is

“highlighted” while the background appears blue

10. Press enter or click on Preview mask – if mask is correct and entire bone is selected,

click on Select

11. Click ctrl + I to invert selection and press delete to remove background

12. Position image in centre of canvas using Move tool

13. If necessary to rotate the image:
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a. Layer > Transform… > Arbitrary rotation and manually rotate 

b. For the skull: Left and right views must be in Frankfort Horizontal. For superior 

and inferior views, rotate so that anterior is up.  

c. For the mandible: For occlusal view, rotate so that anterior is down.  

d. For the long bones: Make sure proximal end is on the left 

14. Click on the background layer in the layers tab. 

15. Use the Bucket Fill tool to fill in the background with black.  

 

Add the Bakeng se Afrika logo  

1. Drag and drop the file of the Bakeng se Afrika logo onto the image in GIMP. 

 
2. Resize layer to change logo size: 

a. Layer > Scale Layer > select % and rescale width and height at the following 

proportions and make sure to keep proportions constrained 

i. Crania at 60%  

ii. Mandibles at 70% 

iii. Femur, Humerus, Radius and Ulna at 80% 

3. Drag the logo to the top right corner of the canvas for crania and long bones, and bottom 

right corner for mandibles. 

4. Press enter. 
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For specific trauma/pathologies 

5. Trauma or pathologies that were photographed up close must be highlighted and
enlarged on one of the views. Select a view that shows the feature well to add a box on
and repeat the above process. Place the image off-centre to allow space for a close-up
photo.

6. Import a close-up photograph of the feature. Use the rectangular marquee tool to select

an area around the feature . Ctrl C, Ctrl V to paste the cropped version onto the
photo. Delete the original feature photo. Select the feature layer and move it to an open
space on the black background.

7. To add boxes select the  tool. At the top of the window, select the style and 

colour. The style with just the outline as shown here 
is most useful for highlighting aspects of an image. Draw a box around the close-up 
of the feature. Make sure that when you have drawn the box that the layer is above 
the images in the Layers panel.   

8. Double-click on ‘Strokes’ under the box layer in the Layers panel. Change the size of
the stroke to 25 and the colour to white.

9. Draw a second box around the feature on the full view of the bone.

10. Using the line tool , draw lines from the corners to connect the boxes on the close-
up and full view images. Change the line weight to 25 and the colour to 

white.
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Step 3: Save and rename the final photo  

Select file > Save as  

Save the image as a .psd (Photoshop file) and a .jpg file. 

• OriginalPhotoNumber_BsA_institution_bone_number_view
o Views = ant, med, left, post, lat, right, sup, inf, occ

• If the photo contains a zoomed-in view of a feature (trauma/pathology), rename the file 

as

OriginalPhotoNumber_BsA_institution_bone_number_view_detail

• Maximise compatibility for .psd file
• JPEG options:

o Image quality = High 

o Format options = Baseline optimized
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